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INTRODUCTION > LITHIUM-ION BATTERY INFORMATION

Lithium-Ion Battery Information
Your iQue® 3000 contains a non-user-replaceable lithium-ion battery. Please observe the following cautions:

• Do not store or use the unit in temperatures above 50°C (122°F) or below 0°C (32°F). Do not store or use the unit near a heat source, 
such as a radiator, stove, or fireplace. If heated, the battery in the unit could explode or vent, posing a risk of fire.

• Do not use any chargers not specified by Garmin. Do not charge the battery under conditions not specified by Garmin, as it may leak 
electrolytes, become hot, or explode.

• Do not put the unit into a fire, as it may swell or explode. Do not use near any type of heat source. If the battery leaks electrolytes or 
emits a strange smell, discontinue use and move the unit away from the heat source.

• Do not submerge the unit in water or any type of liquid. Do not expose the unit to any type of water, such as rain or moisture, as it might 
corrode, become hot, or occasionally not function.

• Keep the unit out of reach of babies and children.
• Do not put the unit in a microwave oven or pressure cooker.
• If you experience any problems with the battery, keep the unit in a safe place and immediately contact Garmin.
• If you must dispose of the unit, contact your local waste disposal department for information on properly disposing of  

lithium-ion batteries.
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INTRODUCTION > SYSTEM REQUIREMENTS

CHAPTER 1: INTRODUCTION TO THE IQUE

With your iQue® handheld, you can successfully manage meetings and appointments, remember people’s names and personal 
details, and keep track of all the items on your To Do List both at work and at home.

You will find it easy to start using the iQue handheld, become familiar with its physical buttons and controls, and use HotSync® 
technology to synchronize (exchange and update) your iQue handheld and Palm™ Desktop software. When you familiarize yourself 
with the basic workings of the iQue handheld, you can easily do the following:

• Enter all your schedule details in the Date Book and view them by the day, week, or month. You can also set an alarm to 
remind you of an important event.

• Keep all your contact names, addresses, phone numbers, and other details in the Address Book.
• Add your tasks to the To Do List, prioritize them, and assign them a due date.
• Ensure that you do not lose any important information by synchronizing your data with Palm Desktop software on your 

computer to create a backup copy.
• Customize your handheld and set different levels of security to prevent unauthorized users from viewing your data.

This manual describes how to use the Palm™ applications included with your iQue handheld. To learn how to use QueNav, the GPS 
software on your iQue 3000, please refer to the Quick Reference Guide included in your product box.

System Requirements
To install and operate Palm Desktop software on your computer, the computer system must meet the following requirements:

• IBM-compatible 486 computer or higher
• 8 MB RAM (memory) minimum, 16 MB recommended (required with Windows NT 4.0)
• 20 MB available hard disk space
• Microsoft® Windows® 98/2000/ME/XP
• VGA monitor or better
• DVD-ROM drive 
• Mouse or other pointing device
• One available USB port

In addition, the following equipment is optional: 
• Modem
• Windows-compatible printer

 
NOTE: The iQue 3000 is not fully compatible with Macintosh computers at this time. For more information, please refer 
to the FAQs link in the Support section of the Garmin Web site, www.garmin.com.

http://www.garmin.com
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INTRODUCTION > IQUE COMPONENTS

iQue Components

Battery icon

iQue screen

Text input area

Application buttons

Scroll buttons

Application buttons

Locating Front Panel Controls
• Battery Icon: Displays the current battery level. When charging, the battery icon contains a lightning bolt symbol.
• iQue Screen: Displays the applications and data stored in your handheld. The screen is touch-sensitive.
• Text Input Area: Write letters and numbers in this area using the Graffiti® 2 alphabet. Chapter 2 explains how to enter data 

using Graffiti 2 characters.
• Application Buttons: Press to activate the individual handheld applications that correspond to the icons marked on the 

buttons: Date Book, Address Book, To Do List, and Que Applications. See “Assigning Applications to Buttons” in Chapter 3 
for details on reassigning these buttons to other applications on your handheld. If your handheld is turned off, pressing any of 
the application buttons turns on the handheld and opens the corresponding application.

• Scroll Buttons: Press to display text and other information that extends beyond the area of the handheld screen. Press the 
lower scroll button to scroll down and view information below the viewing area. Press the upper button to view  
information above the viewing area.

Home

Brightness

Menu

Favorites
(Hotsync by default)

Volume

Palm OS® Find
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INTRODUCTION > IQUE COMPONENTS

Bottom View
Interface connectorAC charger connector

Slots for leather flip cover

Power/Backlight Button

Top View

Stylus

External antenna 
connector

IR port

GPS antenna  
(in down position)

Expansion 
card slot

Headphones jack

Locating Side, Top, Bottom and Back Panel Components
• Power/Backlight Button: Pressing the Power button turns the handheld on or off. When you turn on the handheld, the 

page displayed most previously appears. The LED is amber when the unit is charging and turns green when the unit is 
fully charged. Press and hold the Power button for about two seconds to turn the backlight on or off for changing lighting 
conditions. You may also assign the full-screen pen stroke to activate the backlight. For more information, see “To change 
what the full-screen pen stroke activates” in Chapter 3.

• Stylus: Use to tap icons and buttons on the screen or enter data on the Graffiti® 2 writing area. To use the stylus, remove it 
from the side channel and hold it as you would a pen or pencil.

• External Antenna Connector: Accepts a Garmin low profile remote antenna.
• IR Port: Uses infrared technology to transmit and receive data to and from other iQue or Palm OS® handhelds and to 

perform HotSync® operations. See “Beaming Information” in Chapter 8 and “IR HotSync Operations” in Chapter 9 for more 
information.

• Expansion Card Slot: Accepts microSD expansion cards for flexible memory storage and additional software.
• Headphones Jack: Plug in headphones for listening to MP3 audio files or navigation guidance.
• AC Charger Connector: Connects to the AC wall charger for battery recharge only.
• Interface Connector: Connects your handheld to your computer.
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INTRODUCTION > IQUE COMPONENTS

Flip-up GPS antenna  
(open parallel to 

the horizon for GPS 
navigation)

Speaker

Reset Button

Back Side View

• Reset Button: Under normal circumstances, you should not have to use the reset button. See “Resetting your iQue” later in 
this chapter for information on when and how to use the reset button.

• Speaker: Internal speaker for listening to voice-guided navigation commands and MP3 files.
• Flip-up Integrated GPS Antenna: Open for satellite reception and GPS navigation. To extend battery life, keep the antenna 

closed when you are not using the iQue for navigation.

 
NOTE: This antenna is designed to receive satellite signals most clearly when it is positioned parallel to the horizon. If the 
antenna is positioned vertically, the iQue’s ability to receive satellites may be dramatically reduced. 

Using the Stylus
Just as you use a mouse pointer to click elements on your computer screen, you can use the stylus to tap elements on your 
handheld’s touch-sensitive screen. Tapping is the basic action used to execute tasks on your handheld.

 
IMPORTANT: Always use the point of the stylus for tapping or making strokes on the handheld screen. Do not use a pen, 
pencil, or any other sharp object to write on the handheld screen. If you misplace your stylus, visit www.garmin.com for 
information on a replacement.

With your handheld turned on, you can tap the handheld screen to perform many operations:
• Open applications.
• Choose menu commands.
• Enter data.
• Select options in dialog boxes.
• Open the on-screen keyboard.

Just as you drag the mouse to select text or move objects on your computer, you can drag the stylus on the screen of your iQue to 
select text. In addition, you can use the stylus to drag the slider of any scroll bar.

http://www.garmin.com
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INTRODUCTION > STARTING YOUR HANDHELD AND CALIBRATING THE SCREEN

Starting Your Handheld and Calibrating the Screen
The first time you start the iQue handheld, setup instructions appear on the screen. These instructions include a calibration screen, 
or digitizer. Calibration aligns the internal circuitry of the handheld with its touch-sensitive screen so your handheld can detect 
stylus taps correctly. If you notice that the handheld does not respond properly when you tap the screen with the stylus, you may 
need to calibrate the screen again.

To calibrate your screen:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. In the  pick list in the upper-right corner of the screen, tap Digitizer.
3. Follow the on-screen instructions.

Adjusting the Brightness of Your Screen
To adjust the backlight brightness:
1. Press the Power button to turn on the device.
2. Press and hold the Power button. Then release the button. (Or, tap .)
3. Tap and drag the brightness adjustment slider to the desired level. Then tap Done.

Brightness Adjustment Slider

 
NOTE: Backlight is the most significant factor in reducing or lengthening battery life. Turning the brightness up or 
keeping the backlight on can reduce battery life significantly.
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INTRODUCTION > RESETTING YOUR IQUE

Resetting Your iQue
You may need to perform a reset if your handheld no longer responds to stylus taps or button presses. A soft reset allows your 
handheld to get a fresh start, similar to rebooting a PC. All records and entries are retained after a soft reset.

To perform a soft reset:
 Use the stylus to press and release the Reset button inside the hole on the back of the handheld.

Reset Button

A hard reset erases all records and entries stored in your handheld. Never perform a hard reset unless a soft reset does not correct 
your problem. When you perform your next HotSync® operation, you can restore any data that you previously synchronized to your 
computer.

To perform a hard reset:
1. Press the Reset button as described above. 
2. Immediately after you release the Reset button, press and hold the Power button until you see the Palm Powered™ logo. Then release 

the Power button.
3. When a message appears on the screen warning that all data stored on the handheld is about to be erased, do one of the following:

• Complete the hard reset by pressing the upper half of the scroll button on the front of the handheld. The Digitizer screen appears.
• Press any other button to perform a soft reset.

 
NOTE: When you perform a hard reset, the current date and time are retained. Formats, preferences, and other settings 
are restored to their factory default settings.
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INTRODUCTION > OPENING APPLICATIONS

Opening Applications
You can use the Applications Launcher to open any application installed on your handheld. You can also open the four main 
applications, Date Book, Address Book, To Do List, and QueNav, with the hardware application buttons on the front of your 
handheld.

 
NOTE: When you press a button on the front of your device, the selected application immediately appears, even if the 
device was turned off. 

In addition to providing a way for you to open applications, the Applications Launcher displays the current time, battery level, and 
application category. 

To open an application:
1. Tap the Home (Applications Launcher) icon . Repeatedly tapping  cycles through several application categories.
2. Tap the icon of the application you want to open. If you have many applications installed on your iQue handheld, tap and drag the scroll 

bar or press the Scroll button down to see all of the available applications.

 
TIP: You can find an application quickly by writing the Graffiti® 2 character for the first letter of its name. The Application 
Launcher scrolls to the first application with a name that begins with that letter.

Applications Launcher 
Icon

(Home icon)

Application Icons
Scroll Bar
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INTRODUCTION > USING THE HANDHELD INTERFACE

Using the Handheld Interface

Icons

A Dot
1 Dot

Scroll Bar

Pick List

Your handheld includes the following interface elements:
• Pick lists display a list of choices. Tap the black triangle next to the pick list name to display a list of choices, and then tap an 

item in the list to select it.
• The scroll bar moves through long notes or memos. Tap and drag the scroll bar slider to scroll through pages; tap the slider 

arrow at either end to move one line at a time. To scroll to the previous page, tap the scroll bar just above the slider; to scroll 
to the next page, tap the scroll bar just below the slider. You can also scroll to the previous and next pages by pressing the 
Scroll buttons up or down on the front of the handheld.

• Icons open applications and menus.
• The A dot in the input area activates the alphabetic keyboard when tapped. Note that the cursor must be in an input field for 

this option to work.
• The 1 dot in the input area displays the numeric keyboard when tapped. Note that the cursor must be in an input field for this 

option to work. 
• The menu bar contains a set of menu commands specific to the application. Not all applications have a menu bar.
• The command bar lets you tap icons or write a shortcut stroke to initiate a command instead of tapping a command in the 

menu bar. The icons in the command bar vary within each application. 
• Command buttons initiate a command when tapped. Command buttons appear in dialog boxes and at the bottom of  

application screens (examples: OK or Cancel).
• Check boxes indicate the state of the corresponding option. A check mark in a check box means the option is active. If a 

check box is empty, tap it to insert a check mark. If a check box is checked, tap it to remove the check mark.
• Next/previous arrows display the previous and next page of information.
• Text areas and screens allow you to enter information.
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INTRODUCTION > USING MENUS AND MENU COMMANDS

Using Menus and Menu Commands
Menus on your handheld are easy to use and work the same way in all applications, although the menu commands in each 
application are different. Menu commands for each application are described in Chapters 4 and 5. For information on Edit menu 
commands, see “Using the Edit Menu” in Chapter 5.

Most menu commands have an equivalent Graffiti® 2 command stroke, which is similar to keyboard shortcuts used to execute 
commands on computers. To use Graffiti 2 menu commands, menus must be closed.

To display a menu bar and choose a command, do one of the following: 
• Open an application (such as the Date Book); then tap the Menu icon . Select the desired command from the menu. 
• Tap the tab in the upper-left corner of the screen. Then tap the desired command from the menu. 
• In the text input area of your device’s screen, drag a diagonal line from the lower-left to upper-right to display the  

Command toolbar. The command bar appears for approximately 4 seconds.
• Tap an icon that represents the command you want, or enter the shortcut for the command in the text input area below the 

Command toolbar. For example, to choose Select All in the Edit menu, draw the Graffiti 2 command stroke in the text area to 
display the Command toolbar and then draw the letter S. If you wait more than three seconds to draw the shortcut letter, you 
must redraw the Graffiti 2 command stroke to view the Command toolbar.

Command Toolbar

Displaying Tips
Many of the dialog boxes that appear on your handheld contain a Tips icon  in the upper-right corner. Tips anticipate questions 
you may have and provide shortcuts for using the dialog box or other useful information. 

To display a tip:
1. Tap the Tips icon .
2. When you are finished viewing the tip, tap Done.

Tips Icon
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INTRODUCTION > CUSTOMIZING YOUR HANDHELD

Customizing Your Handheld
You can customize your handheld to do the following:

• Display personal information, such as your name and address.
• Display the current date and time, and different date and time formats for other countries and time zones.
• Shut down after a certain amount of time to save battery life.
• Stay on while in the cradle.
• Play sounds at a certain volume level.
• Automatically receive any data beamed to it.
• Use a color theme.

Personalizing Your Handheld
In Owner Preferences, you can enter a name, company name, phone number, and any other information you want to include on 
your handheld. If you use the Security application to lock your handheld with a password, information that you enter in Owner 
Preferences appears each time you turn on your handheld. 

To change Owner Preferences on your handheld: 
1. Tap the Home icon . Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose Owner.
3. In the Owner Preferences screen, enter the text you want to associate with your handheld. If you enter more text than can fit on one 

screen, a scroll bar appears at the right side of the screen. 

 
NOTE: If you have assigned a password to your device using the Security application, you must unlock the Owner 
Preferences screen to change the information on it. For information about setting a password, see “Assigning and Editing 
Passwords” in Chapter 3.

To unlock the Owner Preferences screen: 
1. Display the Owner Preferences screen as described above.
2. Tap Unlock. The Unlock Message dialog box appears. 
3. Enter your current password (the one you entered in the Security application) and tap OK. 
4. Edit the Owner Preferences text as desired
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INTRODUCTION > SETTING THE DATE, TIME, AND TIME ZONE

Setting the Date, Time, and Time Zone
The Date & Time screen allows you to set the date, time, time zone, and Daylight Saving setting for your handheld.

Date & Time Preferences screen

To set the date:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose Date & Time.
3. In the Date & Time screen, tap the Set Date field. The Set Date screen appears. 
4. Tap the arrows at the top of the Set Date screen to select the current year.
5. Tap the month; then tap the current date. The Set Date screen closes, and the date you selected appears.

To set the time:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose Date & Time.
3. In the Date & Time screen, tap the Set Time field. The Set Time screen appears.
4. Tap the  and  arrows to change the hour. 
5. Tap each minute number, and then tap an arrow to change the number. 
6. If available, tap AM or PM. 
7. Tap OK to set the new time and return to the Date & Time screen.
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INTRODUCTION > SETTING THE DATE, TIME, AND TIME ZONE

 
NOTE: To display time based on a 24-hour clock, change the time format. See “Formatting the date, time, and numbers” 
later in this chapter.

To set the time zone:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose Date & Time.
3. In the Date & Time screen, tap the Set Time Zone field.

Set Time Zone screen
4. Tap the scroll bar arrows or press the Scroll buttons to scroll to your country and time zone.
5. Tap to select your time zone. Then tap OK. The time zone you selected appears in the Time Zone field.

 
TIP: Choose the time zone from the list that corresponds to where you are. When you travel, use this dialog box to change 
time zones. If you are not sure what time zone you are in, find out what time it is, and select the time zone that shows the 
current new time. Do not use the time zone dialog to switch between Daylight Saving time and Standard time; use the 
Daylight Saving pick list.

To set Daylight Saving time:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose Date & Time.
3. Tap the Daylight Saving  pick list and then tap On or Off.
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INTRODUCTION > FORMATTING THE DATE, TIME, AND NUMBERS

Formatting the Date, Time, and Numbers
The Formats Preferences screen allows you to set defaults for time, date, and number formats. You can also preset your handheld to 
use the formats accepted by a certain country. When selecting a country and time, date, and number formats, keep the following in 
mind: 

• When you select a country, the time, date, and number formats are adjusted, as well as the week’s starting day. For example, 
in Germany, time often is expressed using a 24-hour clock and the starting day of the week is Monday. In the United States, 
however, time is expressed using a 12-hour clock with an AM or PM suffix, and the starting day of the week is Sunday. 

• You can customize your own time, date, and number formats without choosing a preset country.
• The Time setting defines the format for the time of day, which appears in all applications on your handheld. 

To choose a country default: 
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose Formats.
3. Tap the Preset To field. The Set Country screen appears. 
4. Tap to highlight a country name. Then tap OK. 

To change time, date, week start, and numbers formats:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose Formats.
3. In the Formats Preferences screen, tap the Time  pick list and select a format, where H is hour and M is minute. 
4. Tap the Date  pick list and select a format, where D is day, M is month, and Y is year.
5. Tap the Week starts  pick list and select whether you want the first day of the week to be Sunday or Monday. 
6. Tap the Numbers  pick list and select formats for the decimal point and thousands separator.

 
NOTE: These settings affect the Day, Week, Month, and Agenda views in Date Book and all other aspects of your handheld 
that display a calendar.
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INTRODUCTION > FORMATTING THE DATE, TIME, AND NUMBERS

Setting the Auto-Off Delay Time
You can set your handheld to shut off automatically after a certain period of time to conserve battery power. Auto shut-off turns off 
the display and backlight after a specified period of inactivity. It is important to remember that if the GPS antenna is open, or if your 
iQue is connected to an external antenna, the iQue will shut off automatically but the GPS receiver will remain on (and continue to 
drain battery life). Be sure to close the GPS antenna or disconnect the iQue from its external antenna to conserve battery power. If 
you find that your handheld shuts itself off before you finish reviewing information on the screen, you can increase the automatic 
shut-off setting.

To set the auto shutoff interval:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose General.
3. In the General Preferences screen, tap the Auto-off After  pick list and choose an auto shut-off time.

Setting Your Handheld to Stay On
In order to save battery power, your handheld shuts off after the time interval you set in General Preferences. Battery power is not 
an issue when your handheld is charging, so you can choose to have the handheld remain on.

To set your device to stay on while in the cradle:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose General.
3. Tap the Stay on in Cradle check box to set your handheld to stay on. If you uncheck the box, your handheld shuts off after the period of 

time that you specify above.
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INTRODUCTION > SETTING THE SOUNDS AND VOLUMES

Setting the Sounds and Volumes
You can control the sound for system alerts, alarms, and games using the General Preferences screen. You can also turn the alarm 
vibrate and alarm LED on and off.

To set alarm and sound volume levels:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose General.
3. To set sounds and volumes, tap the System , Alarm , or Game Sound  pick list and select a sound level.

 
NOTE: Turning off the System Sound also turns off the chime tones used during HotSync® operations. The Game Sound 
setting typically works only with newer games that are programmed to respond to it.

Enabling the  Alarm LED
When you enable the Alarm LED settings, the LED blinks to notify you of alarms. This setting is useful when you want the Alarm 
Sound off, but you still want to be notified of alarms.

To enable the Alarm LED:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose General.
3. Tap the Alarm LED  pick list and select On or Off.

Turning Beam Receive On and Off
Beaming is discussed in Chapter 8. For information on changing the Beam Receive preferences, see “Turning off Beaming” in that 
chapter.

Selecting a Color Theme
You can customize the appearance of your color display by selecting one of more than 30 available color themes. You can also 
choose to automatically switch between a day color theme and a night color theme by checking the Auto-Night box.

To select a color theme:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose General.
3. Tap the Colors  pick list. Tap the scroll arrows to view all menu items.
4. Tap a color theme. Experiment with other color themes by repeating the steps above. Tap the box next to Auto-Night to automatically 

switch to the Night color theme after sunset.
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INTRODUCTION > PALM™ DESKTOP SOFTWARE

Palm™ Desktop Software
Palm Desktop software includes the same main applications as your iQue handheld: Address Book, Date Book, To Do List, Memo 
Pad and desktop e-mail connectivity. You can use HotSync® technology to back up and exchange data between your handheld and 
your computer.

It is a good idea to back up your data frequently in case something happens to the data on your iQue handheld. Changes you make 
on your iQue handheld or Palm Desktop software appear in both places after you synchronize.

Using the Palm Desktop software, you can do the following:
• Work with your iQue handheld applications on your computer. Palm Desktop software duplicates the Date Book, Address 

Book, To Do List, and Memo Pad applications so that you can view, enter, and modify data stored on your handheld.
• Back up the data stored on your handheld with HotSync technology and synchronize the data on your Palm Desktop  

software. Synchronization is a one-step procedure that ensures your data is always safe and up-to-date. See Chapter 9, 
“Exchanging and Updating Data using HotSync Operations” for more information. 

• Import and export data so that you can easily transfer data from other applications on your personal computer into 
applications in your handheld. See “Importing Data” in Chapter 2 for more information.

• Print your Date Book, Address Book, To Do List, and Memo Pad information on any printer.

Installing Palm Desktop Software
For specific instructions on installing Palm Desktop software, please refer to the Setup Guide, included with the Setup disk. You 
need this disk to install the software. After installation, refer to the online Help in Palm Desktop for information on how to use the 
Palm Desktop software.

Using Your Handheld with Another Personal Information Manager
If you prefer to use another Personal Information Manager (PIM), such as Microsoft® Outlook, be sure to install the correct 
connection software, called a conduit. Keep in mind, though, that you must install Palm Desktop software to set up your handheld.
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CHAPTER 2: ENTERING DATA IN YOUR IQUE

You can enter data into your iQue handheld by using the on-screen keyboard, writing with the stylus in the text input area,  
using an external keyboard, or importing data from another application.

Using the On-Screen Keyboard
You can open the on-screen keyboard anytime you need to enter text or numbers on your handheld.

To use the on-screen keyboard:
1. Open any application (such as the Address Book). 
2. Tap any record, or tap New.
3. Tap A on the front of your handheld to display the alphabetic keyboard, or tap 1 on the front of your handheld to display the numeric 

keyboard. To display the international keyboard, tap either A or 1 on the front of your handheld, and then tap Int’l at the bottom of the 
keyboard display. 

The numeric keyboard. The International keyboard.

Tab

Caps Lock

Shift

Backspace

Return/Enter

Tap here to display different keyboards.

Tap A for alphabet keyboard. Tap 1 for numeric keyboard.

4. Tap the desired characters or numbers; then tap Done to enter the text or numbers. 
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Entering Data Using Graffiti® 2 Handwriting Software
You can use Graffiti 2 strokes to enter letters, numbers, punctuation, and symbols. The Graffiti 2 writing strokes include all letters, 
numbers, and symbols found on a standard keyboard.

Learning to Write Graffiti 2 Characters
With only a few minutes of practice, you will find it easy to enter accurate text and numbers using Graffiti 2 writing strokes.

The Graffiti 2 demo shows how to use the handwriting software. The first time you turn on your handheld or perform a hard reset, 
the Welcome application automatically guides you through the setup process. When you complete setup, the iQue invites you to 
learn how to use the handwriting software.

You should try the demo if Graffiti 2 is new to you. After you view the Welcome application the first time, a Graffiti 2 Demo icon 
appears on the Applications Launcher screen. Tap on this icon to view the demo. 

 
TIP: When you reach the Stroke Lookup screen of the demo, use the pick list to view the wide variety of characters that you 
can make. As you tap a character, you see an animation of the strokes used to form that character.
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General Guidelines for Graffiti® 2 Writing
Follow these guidelines to learn and use Graffiti 2 writing strokes successfully:

• To achieve 100% accuracy, practice drawing characters exactly as they appear in the tables later in this chapter.

• The heavy dot in each shape indicates where to start the stroke. Some characters have similar shapes but different starting 
and ending points. Always start your stroke at the heavy dot. (Do not draw the heavy dot; it is only a guideline.) 

• The Graffiti 2 writing strokes for letters closely resemble letters of the standard English alphabet, both uppercase and 
lowercase. Most characters require only a single stroke. When you lift the stylus from the text input area, your handheld 
recognizes and displays the text character immediately. 

 For multi-stroke characters, a temporary character is displayed after the first stroke, to show that the stroke was recognized. 
For example, after the first vertical stroke of “t”, a temporary “l” is shown. There is a short time delay, during which you 
must draw the second stroke. Otherwise, the temporary stroke is recorded.

• The text input area is divided into two parts, one for writing lowercase letters and one for writing numbers. The small marks 
at the top and bottom of the text input area define the division line. To have your handheld recognize letters and numbers, 
you must begin letter strokes on the left side and number strokes on the right side of the text input area. Uppercase letters are 
formed by writing across the division line.

Write lowercase letters here.

Write uppercase letters across the division line.

Write numbers here.
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To write Graffiti® 2 letters:
1. Tap the screen where you want to write text (for example, on a line next to a time in the Date Book). 

Blinking cursor

 
NOTE: A blinking cursor must appear on the screen above the Graffiti 2 writing area before you can begin writing text. 

2. Use the tables on the following pages to find the stroke shape for the letter you want to write. You use the same shape to create both the 
lowercase letter and the uppercase letter 

3. Position the stylus in the left side of the text input area for lowercase letters or across the division line for uppercase letters. 
4. Start your stroke at the heavy dot and draw the stroke shape as it appears in the table. For example, the stroke shown below creates the 

letter n.

Start stroke at heavy dot
Lift stylus here

5. Lift the stylus from the screen at the end of the stroke shape.
6. Your handheld recognizes your stroke immediately and displays the letter at the on-screen insertion point. As soon as you lift the stylus 

from the screen, you can begin the stroke for the next character you want to write.

Graffiti® 2 Tips
When using Graffiti 2 writing, keep the following tips in mind:

• For greater accuracy, draw letters with large strokes; strokes that nearly fill the text input area are easily interpreted. 
• To delete characters, set the insertion point to the right of the character you want to delete. Then draw the Backspace stroke 

(a line from right to left) in the text input area.
• Write at natural speed. Writing too slowly can produce errors.
• Do not write at a slant. Keep vertical strokes parallel to the sides of the text input area.
• When letters and numbers can be written using two different strokes, use the one that is easiest for you. 
• Press firmly.
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The Graffiti® 2 Alphabet
Draw Graffiti 2 letters according to the following alphabet.

Writing Capital Letters
Graffiti® 2 writing automatically capitalizes the first letter of a new record or sentence. To write additional capital letters, use the 
same character stroke used for a lowercase letter, but write across the division line.

Writing Numbers
To write numbers using Graffiti 2 strokes, draw in the right side of the text input area. 

Draw numbers here

Draw numbers using the following strokes.

Writing Punctuation Marks and Other Special Characters
Using Graffiti 2 writing, you can create any punctuation symbol or special character available on any standard keyboard. 

The period and comma punctuation marks can be written on either side of the text input area (the letter or number side). Other 
common punctuation marks can be written on one side or the other of the text input area according to the chart below (in general, 
more frequently used punctuation is on the left side).



22 iQue® 3000 Operating Instructions

ENTERING DATA > ENTERING DATA USING GRAFFITI® 2 HANDWRITING SOFTWARE

Writing Accent Marks
When writing letters with accent marks, first write the letter stroke on the left side (or in the center for uppercase letters) of the input 
area. Then quickly write the accent stroke on the right side of the input area, as shown in the following illustration.

Writing Symbols and other Special Characters
Use the Shift command to write Symbols and other special characters. To use the Shift command, make a vertical stroke from 
the bottom to the top in the text input area. A Shift indicator arrow  appears in the lower-right corner of the screen. While this 
arrow is visible, you can make the punctuation shift characters shown in the following illustration. When the arrow goes away, the 
punctuation mark appears. 

 
TIP: Using an additional Shift stroke to finish writing the character (as shown in the demo) is optional, but it makes the 
character appear more quickly.

Draw punctuation and symbols using the Punctuation Shift command and the following strokes:

Note that when you write punctuation characters with the Shift command, you can write them on either side of the text input area. 
Even though this requires writing an additional stroke, you may find it more convenient because you do not have to remember on 
which side of the input area to make the stroke.

 
TIP: Samples of the character strokes are available in the Graffiti® 2 Help file. To view the Help file, drag the stylus from 
the text input area to the top of the screen. Note that the accented characters appear on a Punctuation Shift screen but do 
not use the Shift command. To write uppercase accented characters, write the letter across the division mark, just as you 
would an ordinary letter.
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Using Graffiti® 2 Gestures
Gestures are editing commands, such as cut, copy, and paste. To use gestures, draw the following strokes:

Using Graffiti® 2 ShortCuts
Graffiti 2 ShortCuts allow you to quickly enter commonly-used words or phrases. ShortCuts are similar to the Glossary or Autotext 
features of some word processors. Graffiti 2 writing comes with several predefined ShortCuts. You can also create your own 
ShortCuts for any words, letters, or numbers.

You can create ShortCuts for words or phrases up to 45 characters long using ShortCut preferences. For example, you could create a 
ShortCut for your name or for the header of a memo. All ShortCuts you create appear on the list in the ShortCut Preferences screen. 
ShortCuts are available in any of your handheld applications and are backed up on your computer when you perform a HotSync® 
operation.

Your handheld includes the following predefined Graffiti 2 ShortCuts for common entries:
• ds—Date stamp
• ts—Time stamp
• dts—Date/time stamp
• me—Meeting
• br—Breakfast
• lu—Lunch
• di—Dinner

To use a ShortCut, draw the ShortCut stroke followed by the ShortCut character or characters. When you draw the ShortCut stroke, 
the ShortCut symbol appears at the insertion point.

Shortcut stroke
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To create a ShortCut:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose ShortCuts.
3. Tap New. The ShortCut Entry screen appears.

4. Tap the ShortCut Name line and enter the letters you want to use to activate the ShortCut.

5. Tap the ShortCut Text area and enter the text you want to appear when you write the ShortCut characters. You can add a space 
character after the last word in your ShortCut text so that a space always follows the ShortCut text.

6. Tap OK.

To edit a ShortCut:
1. In the ShortCut Preferences screen, tap the ShortCut you want to edit.
2. Tap Edit.
3. Make the changes you want, then tap OK.

To delete a ShortCut:
1. In the ShortCut Preferences screen, tap the ShortCut you want to delete.
2. Tap Delete; then tap Yes.
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Using the Graffiti® 2 Tuner
The Graffiti 2 tuner allows you to use alternate strokes for making the characters T, P, Y and $. For example, you may want to form 
the letter “T” by using strokes similar to a space and an “L”.

To use the tuner:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose Graffiti 2.
3. Tap one of the letters available for you to tune. Tap to check the box if you want to use the alternate strokes described to enter that 

character. Then tap Done.

Tap on Graffiti 2 here.
Tap on a letter to tune.

Using Your Computer Keyboard
At times, you may prefer to use your computer keyboard rather than the on-screen keyboard to enter information or add new 
records to your handheld.

You can enter information from your computer keyboard using Palm™ Desktop software or any supported personal information 
manager (PIM) installed for use with your handheld. You can then perform a HotSync® operation to synchronize the information on 
your computer with the information you entered on your handheld. All the main applications on your handheld are available in Palm 
Desktop software and in most PIMs.

Refer to the Palm Desktop online Help for more information on entering data on your computer.
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Importing Data
If you have data stored in computer applications such as spreadsheets and databases, or if you want to import data from another 
device, you can transfer the data to your iQue handheld without having to enter it manually. Save the data in one of the file formats 
listed below, import it into Palm™ Desktop software, and then perform a HotSync® operation to transfer the data to your handheld.

Palm Desktop software can import data in the following file formats: 
• Comma delimited (.csv, .txt): Address Book and Memo Pad only.
• Tab delimited (.tab, .tsv, .txt): Address Book and Memo Pad only.
• CSV (Lotus Organizer 2.x/97 Mapping): Address Book only.
• Date Book archive (.dba).
• Address Book archive (.aba).
• To Do List archive (.tda).
• Memo Pad archive (.mpa).

Archive formats can only be used with Palm Desktop software. Use the archive file formats to share information with other people 
who use Palm Powered™ handhelds or to create a copy of your important Palm Desktop information.

To import data:
1. Open Palm Desktop software.
2. Click to select the application where you want to import data.
3. If you are importing records that contain a field with category names, do the following:

a. Select All in the Category box at the top of the window.
b. Make sure that the same categories that appear in the imported file also exist in the application. If the categories do not exist, create 

them now; otherwise, the records will be imported into the Unfiled category.
4. Choose File > Import. Then select the file you want to import and click Open. 
5. To import data into the correct Palm Desktop fields, drag fields in the left column so that they are opposite the  

corresponding imported field on the right.
6. To exclude a field from being imported, deselect the check box for that field. 
7. Click OK. The imported data is highlighted in the application.
8. To add the imported data to your handheld, perform a HotSync operation.

See Palm Desktop online Help for more information on importing and exporting data.
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CHAPTER 3: MANAGING APPLICATIONS

This chapter explains how to switch between applications on your iQue handheld, how to personalize application settings, and how 
to categorize applications into related groups. 

Using the Applications Launcher
The Applications Launcher displays all the available applications on your handheld by default. You can also display only selected 
applications by arranging applications into categories. To open the Applications Launcher, tap the Home (Applications Launcher) 
icon .

Home (Applications 
Launcher) icon

Application icons

Application category

Menu icon

Selecting Applications
Your iQue handheld is equipped with a variety of applications. All the applications installed on your handheld appear in the 
Applications Launcher. In addition to providing a way for you to open applications, the Applications Launcher displays the current 
time, battery level, and application category. 

To open an application, choose from the following options:
• Tap the Home (Applications Launcher) icon ; then tap the icon of the application you want to open. If you have many 

applications installed on your iQue handheld, tap the scroll bar to see all available applications. 
• Press an application button on the front panel to display the selected application immediately. 

 
NOTE: To switch between applications, tap the Applications Launcher icon or press an application button on the front 
panel of your handheld. Your handheld automatically saves your work in the current application and displays it when you 
return to that application.
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Categorizing Applications
Categories can help you manage the number of application icons that appear on screen in the Applications Launcher. You can assign 
an application to a category and then display a single category or display all your applications. 

To create a new application category:
1. Tap the Home icon . Then tap the Menu icon .
2. Tap the App menu and then tap Category. 
3. Tap the  pick list for any application and select Edit Categories.... Then tap New.
4. Enter a new category name and tap OK. Then tap OK to close.

To categorize an application: 
1. Tap the Home icon . Then tap the Menu icon .
2. Tap the App menu and then tap Category. 
3. Tap the  pick list for the application you want to categorize. Choose a category from the list.
4. Tap Done.

To display applications by category:
1. Tap the Home icon .
2. Do one of the following:

• Tap the Applications Launcher icon repeatedly to cycle through all the categories.
• Tap the pick list in the upper-right corner of the screen; then tap the category you want to display.

Changing the Applications Launcher Display
By default, the Applications Launcher displays applications as icons. As an alternative, you can display applications in a list format. 

To change the view of applications:
1. Tap the Home icon . Then tap the Menu icon . 
2. Tap the Options menu and then tap Preferences. 
3. From the View By  pick list, tap List. Then tap OK to see your applications in list format. 

“Main” applications in list format
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In addition to displaying applications by icon or list, you can display the last-selected category of applications each time you open 
the Applications Launcher.

To display the last-selected category of applications:
1. Tap the Home icon . Then tap the Menu icon .
2. Tap the Options menu and then tap Preferences. 
3. In the Preferences dialog box, tap the box next to Remember Last Category.
4. Tap OK. Each time you return to the Applications Launcher, the handheld displays the last category of applications you selected. 

 
NOTE: If you do not select the Remember Last Category option, all applications display when you open the Applications 
Launcher. 

Setting Preferences for Applications
You can set preferences for individual applications in the Preferences dialog box. Not all applications have preference settings. 

To set preferences for an application: 
1. Open an application. For instructions, see “Selecting Applications” earlier in this chapter.
2. Tap the Menu icon .
3. Tap the Options menu, and then tap Preferences. 
4. Enter the desired preference settings and tap OK.

Assigning Applications to Buttons
Buttons Preferences allows you to assign different applications to the buttons on the front of the handheld and to the HotSync® 
button on the cradle. For example, if you find that you seldom use the To Do List and often use the Memo Pad, you can assign the 
To Do List button to start the Memo Pad application.

You can also change whether the full-screen pen stroke activates the Graffiti® 2 Help application or another handheld command 
using Buttons Preferences.

If you assign a different application to a button, you can still select the original application using the Applications Launcher. 
Changes made in the Buttons Preferences screen or HotSync Buttons dialog box take effect immediately. 

To change the Buttons Preferences:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. In the  pick list in the upper-right corner, tap Buttons.
3. In the Buttons Preferences screen, tap the  pick list next to the button you want to re-assign.
4. Tap the application that you want to assign to the button. 

 
TIP: To restore all of the buttons to their factory settings, tap Default.
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To change what the full-screen pen stroke activates:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner and choose Buttons.
3. In the Buttons Preferences screen, tap Pen.
4. Tap the  pick list and choose a command or control to activate with the full-screen pen stroke:

• Backlight turns on the backlight of your handheld.
• Keyboard opens the on-screen keyboard for entering text characters.
• Graffiti® 2 Help opens a series of screens that show the complete Graffiti character set.
• Turn Off & Lock turns off and locks the handheld. You must assign a password to lock the handheld. When locked, you must enter 

the password to use your handheld.
• Beam Data beams the current record to another Garmin or Palm Powered™ organizer.

5. Tap OK.
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Installing Add-On Applications
In addition to the applications that came with your handheld, you can install other applications (called add-on applications) using 
the Install Tool during a HotSync® operation. Add-on applications reside in RAM memory and can be removed at any time; for 
information, see “Removing Applications” later in this chapter.

Some third-party applications are included on the iQue Setup disk. Just click the applications you want to add to your iQue, and 
they will be installed the next time you perform a HotSync operation.

A variety of additional third-party applications, such as games and other software, are available for your device from the following 
Web site: http://www.palmsource.com/applications. 

To install add-on applications onto your handheld:
1. From your personal computer, copy or download the applications you want to install into the add-on folder in your Palm™ Desktop 

directory or into another folder you can find easily.
2. If the application is compressed, decompress the application before continuing.
3. Double-click the Palm Desktop icon on your computer desktop to open it; then click Install. 

(Continued on next page.)

http://www.palmsource.com/applications
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TIP: You can also select the Install Tool dialog box by double-clicking any file with a PRC file extension.

4. In the User drop-down list, select the user name that corresponds to your iQue handheld. Then click Add. 
5. Locate the file where you saved the new application. Select the application, and then click Open. The file appears in the Palm™ Install 

Tool dialog box. 
6. If you decide not to install an application, select it in the list of files in the Palm Install Tool dialog box, and then click Remove. The 

application is removed from the dialog box list, but not from your computer. 
7. Click Done. A message appears to indicate that the selected applications will be installed the next time you perform a HotSync® 

operation. 
8. Perform a HotSync operation to install the applications. See Chapter 9, “Exchanging and Updating Data Using HotSync Operations” for 

more information.

Removing Applications
You can remove add-on applications, patches, and extensions from your handheld if you run out of memory or no longer want them. 
However, you cannot remove the built-in applications that reside in the ROM portion of your device, including the Date Book, 
Address Book, To Do List, Memo Pad, and Calculator applications.

To remove an add-on application: 
1. Tap the Home icon . Then tap the Menu icon .
2. Tap the App menu, and then tap Delete.
3. In the Delete dialog box, tap the application you want to remove. 
4. Tap Delete. Then tap Yes.
5. Tap Done.
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Removing Palm™ Desktop Software
If you no longer want to use Palm Desktop software, you can remove it from your computer. 

To remove Palm Desktop software on Windows®: 
1. On your personal computer, click the Start menu and choose Settings > Control Panel.
2. Click the Add/Remove Programs icon. 
3. Select Palm Desktop software; then click Add/Remove (or Change/Remove.)

 
NOTE: You must retain the HotSync® Manager from the Setup disk to synchronize data with another PIM.

Assigning Security Options
Your handheld includes a Security application that protects your handheld from other users in a variety of ways:

• Mask or hide entries you have defined as private. The Mask option displays a gray bar over private records, and the Hide 
option completely removes (hides) private records. 

• Assign a password to viewing options to enhance security. Assigning a password requires you to enter a password before 
private entries can be viewed; not assigning a password lets you view private entries when you Show Records from the 
Security dialog box. 

• Lock and turn off your handheld so that a password must be entered before you can use the device again. 
• Hide records that you have defined as private, with or without a password. Without a password, private records are hidden 

until you set the Security application to display them; with a password, you must enter the password to view the private 
entries.

Masking and Hiding Records
You can mask or hide private records. When you mask private records, a visual placeholder appears where the record would 
normally appear; when you hide records, they are not visible anywhere in the list. To mask a record, you must mark it as private 
first.

To mark a record as private:
1. Open the application where you want to make a record private.
2. Tap to highlight the record.
3. In the Address Book, tap Edit and then Details. In other applications, tap Details.
4. Tap to check the box next to Private and then tap OK.

To mask private records:
1. Make sure that the record or records you want to mask are defined as private.
2. Tap the Home icon . Select System from the  pick list in the upper-right corner. Then tap the Security icon .
3. Tap the Current Privacy  pick list and then tap Mask Records. 
 (Continued on next page.)
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4. Open one of the basic applications and view a record. Records marked as private are masked with a gray bar. 

To hide private records:
1. Make sure that the record or records you want to hide are defined as private. 
2. Tap the Home icon . Select System from the  pick list in the upper-right corner. Then tap the Security icon .
3. Tap the Current Privacy  pick list and then tap Hide Records. When you return to an application, records marked as private are not 

included in the list of records.

 
NOTE: You can mask or hide records without assigning a password, or you can assign a password if you want records to 
remain masked or hidden until a password is entered. 

Assigning and Editing Passwords
You can assign a password to protect your private records and to lock your handheld. When you define a password, you can change 
or delete it at any time. You must enter the current password before you can change or delete it. 

If you have forgotten your password, you can delete it. See “Recovering From a Forgotten Password” later in this chapter.

To assign, change, or delete a password:
1. Tap the Home icon . Select System from the  pick list in the upper-right corner.  Then tap the Security icon .
2. Tap the Password field. 
3. To set a new password, enter the password, and enter a Hint if you desire. To change an existing password, enter that password. Then 

tap OK.
4. Choose from the following options:

• To assign a new password, enter the password again to verify it and tap OK. 
• To change your password, enter a new password and tap OK.
• To delete your password, tap Unassign.
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Locking Your Handheld
You can turn off and lock your handheld with a password to protect information. You must then enter the password when you turn 
on your device to view information on it. 

If you forget the password, you must perform a hard reset to resume using your handheld. Performing a hard reset deletes all the 
records in your handheld; however, you can restore all synchronized data at the next HotSync® operation. See “Performing a Hard 
Reset” in Chapter 1 for more information. 

To lock your handheld with a password:
1. Assign a password, as described in “Assigning and editing passwords” earlier in this chapter. 
2. After you enter the password, tap the Auto Lock Handheld field in the Security screen.
3. Enter your current password and tap OK.
4. Choose an option for when you want to lock your handheld. Then tap OK.
5. To turn off and lock your handheld immediately, tap Lock & Turn Off....

To turn on and unlock your handheld:
1. Turn on your device. 
2. Enter your password at the prompt; then tap OK. 

Recovering From a Forgotten Password
If the Off & Lock option is not active, and you forget your password, you can delete the forgotten password from your handheld. 
Deleting a forgotten password also deletes all entries and files marked as private.

 
IMPORTANT: If you synchronize with your computer before deleting a forgotten password, your handheld restores private 
entries the next time you perform a HotSync operation, but does not restore the forgotten password. 

To delete a forgotten password:
1. Tap the Home icon . Select System from the  pick list in the upper-right corner.  Then tap the Security icon .
2. Tap the Password field. Then tap Lost Password.
3. Tap Yes to confirm deleting the forgotten password.
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CHAPTER 4: USING BASIC APPLICATIONS

Your iQue Palm OS® handheld with integrated GPS includes the following basic applications:
• Date Book    •   Memo Pad
• To Do List    •   Calculator
• Address Book   •   Que Applications

This chapter describes how to perform tasks that are specific to the basic applications of your iQue Palm OS handheld—like 
how to schedule appointments in the Date Book and enter names and addresses in the Address Book. For detailed information on 
performing tasks with the Que applications, please refer to the Quick Reference Guide that came with your iQue handheld. 

Using the Date Book
The Date Book lets you quickly and easily schedule appointments or activities associated with a date or date and time. When you 
open the Date Book, it displays the current date and a list of times for a standard business day. 

Use the Date Book to do the following: 
• Schedule events. 
• Display your schedule by Day, Week, Month, or Agenda view. 
• Set an alarm to sound minutes, hours, or days before a scheduled appointment. 
• Attach notes to events to describe or clarify Date Book entries. 
• Rearrange or delete events from your schedule.

To open the Date Book:
 Press the Date Book button on your handheld to open the Date Book to today’s schedule. The date displays in the upper-right corner of 

the screen. 

 
NOTE: Press the Date Book button repeatedly to cycle through the Day, Week, Month, and Agenda views. The Date Book 
views appear in the lower-left of the screen.

Date Book button
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Scheduling Events
An entry in the Date Book is called an event. When you schedule an event, its description appears on the time line and its duration 
is set to one hour by default. You can easily change the start time and duration for any event. You can schedule the following types 
of events in the Date Book:

• Timed events, such as meetings, that have a specific date and a specific start and end time. 
• Untimed events, such as birthdays, holidays, and anniversaries. These events occur on a particular date but have no specific 

start or end times; they appear at the top of the list of times marked with a diamond. You can schedule more than one untimed 
event on the same date. 

• Repeating events, such as weekly meetings that are held on the same day at the same time each week. 
• Continuous events, such as vacations or conferences.
• All day events, which reflect the default length of the day as set by the user. 

Scheduling Timed Events
You can schedule timed events for the current date or for future dates. 

To schedule a timed event for the current date:
1. Press the Date Book button on your handheld to open the Date Book to today’s schedule. Day View displays the current date and a list 

of times for a normal business day.
2. With the current day selected, tap the line next to the time that corresponds to the start of the event. 

Time bar 
shows default 

duration.

Tap a line next to 
the desired time; 
then enter text.

3. Enter a description of the event, up to 255 characters in length.
 (Continued on next page.)
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Tap the time  
to display  

the Set Time  
dialog box.

4. Set the duration for the event:
• If the event is one hour long, skip to the end of this procedure.
• If the event is longer or shorter than an hour, tap directly on the time to open the Set Time dialog box.

 
TIP: You can open the Set Time dialog box (to select a start time) by making sure no event is selected, and then writing a 
number on the number side of the text input area.

5. Set the duration of the event in either of the following ways:
• Tap the time columns in the Set Time dialog box to set the Start Time. Then tap End Time and tap the time columns to set the End 

Time.
• Tap All Day if the event lasts all day. The default hours of a standard business day are set by the user, and can be changed using 

the Preferences command in the Date Book application. See “Changing the Displayed Start and End Times” later in this chapter.

Tap to scroll to earlier hours

Start Time highlighted
Tap to change hours

Tap to change minutes

Tap to scroll to later hours

6. Tap OK.
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To schedule a timed event for another date:
1. Select the date you want in one of the following ways: 

• Tap the desired day of the week in the date bar at the top of the screen. If necessary, tap the Previous week or Next week scroll 
arrows to move to another week.

• Tap Go To at the bottom of the screen to open the Go to Date dialog box. Select a date by tapping a year, month, and day in the 
calendar.

2. After locating the desired date, follow the steps for scheduling an event for the current day.

 
NOTE: You can also use the Details button to change the date of an event.

Scheduling Untimed Events
You can schedule untimed events for any date. Untimed events appear at the top of the list of times and are marked with  
a diamond. 

To schedule an untimed event:
1. Select the event date you want as described in the previous procedure, “To schedule a timed event for another date.” 
2. Tap New.
3. In the Set Time dialog box, tap No Time.

 
NOTE: You can tap OK instead, but make sure nothing is entered for start or end time.

 
TIP: You can create a new untimed event by making sure no event is selected and then writing letters in the text input area. 
When you start writing, the untimed event appears at the top of the screen.

4. Enter a description of the event.
5. Tap a blank area on the screen to deselect the untimed event.

 
NOTE: If you create a timed event and later want to make it an untimed event, tap directly on the event time on the Date 
Book screen; then tap No Time and tap OK. 

New untimed event
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Scheduling Repeating or Continuous Events
The Repeat function lets you schedule events that recur at regular intervals or extend over a period of consecutive days. Repeating 
events include a birthday or a weekly guitar lesson that falls on the same day of the week and the same time of day. Continuous 
events might include a business trip or a vacation.

To schedule a repeating or continuous event:
1. Tap the event (Be sure to tap the event and not the time next to the event). Typically, a continuous event is an untimed event.
2. Tap Details.
3. Tap the Repeat box to open the Change Repeat dialog box.

Tap the  
Repeat 

box

4. Tap Day, Week, Month, or Year to set how often the event repeats. For a continuous event, tap Day.
5. Enter a number that corresponds to how often you want the event to repeat on the Every line. For example, if you select Month and 

enter the number 2, the event repeats every other month.
6. To set an end date for the repeating or continuous event, tap the  End On pick list and tap Choose Date. Use the date picker to select 

an end date.
7. Tap OK. An icon that represents a repeating event appears to the far right on the event line.
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Changing Repeating or Continuous Events
When you make changes to a repeating or continuous event, you can apply the change just to the current event, to the current event 
and all future occurrences of this event, or to all occurrences of this event—past, present, and future.

To change a repeating or continuous event:
1. Select the event you want to delete.
2. Tap Details. The Event Details screen opens.
3. Tap Delete. The Repeating Event screen opens asking for confirmation of the delete.

 
TIP: You can also select Delete Event from the Record menu. This opens the Repeating Event screen.

Tap Delete

4. Select one of the following options:
• Current deletes a single occurrence of this event
• Future deletes the current event and all future occurrences of this event
• All deletes all past, current, and future occurrences of this event.

The event is removed from your Date Book, and you are returned to the day view where you started. These steps apply to all 
changes you make to repeating or continuous events.
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Tips for Scheduling Repeating or Continuous Events
Keep the following in mind when scheduling repeating or continuous events:

• If you change the start date of a repeating event, your handheld calculates the number of days you moved the event. Your 
handheld then automatically changes the end date to maintain the duration of the repeating event.

• If you change the repeat interval (for example, from daily to weekly) of a repeating event, past occurrences (prior to the day 
on which you change the setting) are not changed, and your handheld creates a new repeating event.

• If you change the date of an occurrence of a repeating event (for example, from January 14 to January 15) and apply the 
change to all occurrences, the new date becomes the start date of the repeating event. Your handheld adjusts the end date to 
maintain the duration of the event.

• If you change other repeat settings (for example, time, alarm, private) of a repeating event and apply the change to all 
occurrences, your handheld creates a new event. The start date of this new event is the day on which the setting is changed. 
Past occurrences (prior to the day of the change) are not changed.

• If you apply a change to a single occurrence of a repeating event (for example, time), that occurrence no longer shows the 
Repeat icon.

Rescheduling Events
You reschedule events using the Details option in the Date Book. You can also use the Details option to convert untimed events into 
timed events. 

To reschedule an event:
1. Tap the event you want to reschedule.
2. Tap Details.
3. To change the time, tap the Time box, select a new time, and then tap OK. 
4. To change the date, tap the Date box, select a new date, and then tap OK.

Adding Address Book Information and Attaching a Location to an Event
You can add a name, address, and telephone number to an event using the Phone Lookup option. For instructions, see “Using Phone 
Lookup” in Chapter 5. For information on attaching a location to an event, refer to the Quick Reference Guide.
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Setting Alarms
The Alarm setting lets you set an audible alarm for events in your Date Book, and display a reminder message on-screen. For 
untimed events, only the reminder message appears.

Setting an Alarm for an Event
You can set an alarm for minutes, hours, or days before an event. When you set an alarm, an Alarm icon appears to the far right of 
the event with the alarm. 

You can also set a silent alarm for untimed events that displays a reminder message on-screen before the day of the event. The 
alarm triggers at the specified period of minutes, hours, or days before midnight of the day on which the untimed event begins. 

For example, you set a 5-minute alarm for an untimed event that occurs on February 4. The reminder message appears at 11:55 p.m. 
on the night of February 3. The reminder remains on-screen until you turn on your handheld and tap OK to turn off the reminder.

To set an alarm for an event:
1. Tap the event to which you want to assign an alarm.
2. Tap Details.
3. Tap the Alarm check box to select it. The default setting, 5 Minutes, appears.
4. Set the alarm time:

• Select the 5 next to the Alarm check box and enter any number from 0 to 99 (inclusive) as the number  
of time units.

• Tap the  pick list to change the time unit; select Minutes, Hours, or Days.

Enter number of  
time units here.

Tap here to select 
unit of time.

5. Tap OK.
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Once an alarm has sounded, you can tap the Snooze option to dismiss the alarm for five minutes. 

To dismiss the alarm using the snooze option:
 When the Alarm dialog box appears, tap Snooze to delay the alarm for a preset five-minute period. Each time you tap Snooze, the alarm 

is dismissed for an additional five minutes. 

Setting Alarm Options
You can set the alarm to sound automatically for each new event using Preferences. You can also set a tone for the alarm and the 
number of times the alarm sounds. 

To set alarm options:
1. Open the Preferences dialog box in one of the following ways: 

• In the Date Book, tap the Menu icon .
• Tap the inverted tab at the top of the Date Book screen to display the menu bar.
• In the text input area, drag a diagonal line from the lower-left to upper-right to display the Command toolbar. Type an R, the Graffiti® 

2 shortcut for the Preferences command. 
2. In the Options menu, tap Preferences. 
3. Select from the following options: 

• Tap Alarm Preset to set an alarm for each new event automatically. The silent alarm for 
untimed events is defined by minutes, days, or hours before midnight of the date of the 
event. 

• Tap the Alarm Sound pick list, and then tap an option to set the tone of the alarm. 
Options include Alarm, Alert, Bird, Concert, Phone, Sci-fi, and Wake Up.

• Tap Remind Me to define how many times the alarm sounds—once or twice; or three, 
five, or ten times.

• Tap Play Every to set how often the alarm sounds—every minute; or every 5, 10, or 30 
minutes.

4. Tap OK.
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Changing the Date Book View
The Date Book includes four views for displaying your appointments: Day view, Week view, Month view, and Agenda view. 

To display the Date Book views, do one of the following:
• Press the Date Book application button repeatedly to cycle through all the Date Book views. 
• Tap a view icon in the lower-left area of the Date Book screen.

Date Book View icons

To display the current time:
1. Tap and hold down the stylus on the date in the date bar to display the time. (When you release the stylus, the menu bar appears.) 
2. Drag the stylus away from the date and then lift to release without displaying the menu bar.
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Working in Week View
Week view displays a calendar of your events for an entire week. This view lets you quickly review your appointments and 
available time slots. In addition, the graphical display helps you spot overlaps and conflicts in your schedule.

To display Week View:
1. Tap the Week view icon or press the Date Book button until the Week view appears. 

Week view icon
2. Tap the left and right navigation controls to move forward or backward a week at a time, or tap on a specific day to display the details of 

an event. 

 
NOTE: The Week View also shows untimed events and events before and after the range of times displayed.

Next WeekPrevious Week

Bar indicates earlier event

Dot indicates untimed event

3. Tap an event to display a description of the event at the top of the screen.
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Tips for Using Week View
Keep the following points in mind when using Week view: 

• To reschedule an event while in Week view, tap and drag the event to a different time or day.
• Tap a blank time on any day to move to that day and select that time for a new event. 
• Tap any day or date that appears at the top of the Week view to move directly to that day without selecting an event.
• The Week view displays the time span defined by the Start Time and End Time in the Date Book Preferences settings. If you 

have an event before or after this time span, a bar appears at the top or bottom of that day’s column. Use the on-screen scroll 
arrows to scroll to the event.

Spotting Event Conflicts
With the ability to define specific start and end times for any event, it is possible to schedule events that overlap (an event that starts 
before a previous event finishes).

An event conflict (time overlap) appears in the Week view as overlapping time bars and in the Day view as overlapping brackets to 
the left of the conflicting times.

Event 
conflicts
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Working in Month View
The Month View screen shows which days have events scheduled. Dots and lines in the Month view indicate events, repeating 
events, and untimed events. A dashed line indicates a continuous event, a dot on the right side indicates an event, and a dot below 
the date indicates an untimed event.

Month View icon

Previous/Next Month

You can control the dots and lines that appear in the Month View. See “Changing the Date Book Display” later in this chapter for 
more information.

Tips for Using Month View
Keep the following points in mind when using the Month view: 

• Tap a day in the Month view to display that day in the Day view.
• Tap the scroll arrows in the upper-right corner to move forward or backward a month. 
• Tap Go To to open the date selector and select a different month.
• Use the scroll buttons on the front panel of your handheld to move between months. Press the top button to display the 

previous month, the bottom button to display the next month. 

Working in Agenda View
The Agenda view lets you view appointments, untimed events, and To Do List items in a single screen. Although it is primarily a 
viewing option, you can also use the Agenda view to check off completed To Do List items. To go to a Day View of any event on 
the Agenda view screen, simply tap the desired event. 

To display the Agenda View:
1. Tap the Agenda view icon or press the Date Book button until the Agenda view appears.

Agenda View icon
2. Use the navigation bars to move forward or backward a day at a time or to display more To Do items.
 (Continued on next page.)
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Tips for Using Agenda View
• Tap any appointment while in Agenda view to display the Day View of the appointment. 
• Check off completed To Do List items in the Agenda view, or click a description of an item to go directly to the To Do List 

application. 
• You can change the category of To Do items shown. Tap on the pick list and select the new category. See “Using the To Do 

List” later in this chapter for more information on To Do items.

Changing the Date Book Display
In Day or Month view, you can change which events appear in the Date Book. In Day view, you can display time bars that highlight 
event conflicts.

To change the Date Book display of events:
1. In Day view or Month view, tap the Menu  icon.
2. Tap Options, and then tap Display Options.

 (Continued on next page.)
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3. For Day view, select from the following options:
• Tap Show Time Bars to display time bars showing the duration of an event and any event conflicts.
•  Tap Compress Day View to display start and end times for each event, but no blank time slots at the bottom of the screen, to 

minimize scrolling. Clear the option to display all time slots.
4. For Month view, select whether to display Timed, Untimed, or Daily Repeating events.
5. Tap OK.

Changing the Displayed Start and End Times
You can change the preferences used for new entries. Preferences include display starting time, display ending time, and alarm 
characteristics. See “Setting Alarm Options” earlier in this chapter for more information on alarm preferences.

To change the start and end time in the Date Book:
1. In the Date Book, tap the Menu  icon.
2. Tap Options, and then tap Preferences.

3. Tap Start Time and use the scroll arrows to select a new start time for the Date Book screens. Repeat the step to set a new end time. If 
the time slots you select do not fit on one screen, tap the scroll arrows to scroll up and down.

4. Tap OK.

 
NOTE: The Start and End Time are used by the various Date Book screens. The Day view schedules events to start and 
end at these times when the All Day option is selected. The Week view displays the time span defined by the Start Time and 
End Time.
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Using the Address Book
 The Address Book lets you keep names, addresses, telephone numbers, and other information about your personal or business 
contacts.

Use the Address Book to do the following: 
• Quickly enter, look up, or duplicate names, addresses, phone numbers, and other information.
• Enter up to five phone numbers (home, work, fax, car, and so on) or e-mail addresses for each name.
• Define which phone number appears in the Address List for each Address Book entry. 
• Attach a note to each Address Book entry so you can enter additional information about the entry.
• Assign Address Book entries to categories so that you can organize and view them in logical groups.

To open the Address Book:
 Press the Address Book button on the front panel of your handheld to open the Address Book and display the list of all your records.

Address Book button

 
NOTE: Press the Address Book button repeatedly to cycle through the categories in which you have records.
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Adding and Using Address Book Entries
The Address Book application stores name and address information about people or businesses.

A record in Address Book is called an entry. You can create entries on your handheld, or you can use the Palm™ Desktop software to 
create entries on your computer and then download them to your handheld with your next HotSync® operation.

Palm Desktop software also has data import capabilities that let you load database files into the Address Book on your handheld. 
See Palm Desktop online Help for more information.

To create a new Address Book entry:
1. Press the Address Book button on the front of your handheld to display the Address list.
2. Tap New.

3. Enter the last name of the person you want to add to your Address Book. 
4. Tap the First Name field to move to it. (You can move to any field by tapping it directly.) Enter the individual’s first name in the First 

Name field.
5. If you want to be able to sort the Address Book by company name, enter the information you want in the Company field. 
6. Enter any other information that you want to include in the entry.
7. Tap the scroll arrows to move to the next page of information.
8. To attach a note to an entry, tap Note. Enter the information you want in the text input area, and then tap Done. To attach a GPS location 

to an entry, please refer to the Quick Reference Guide.
9. When you have finished entering information, tap Done.

 
TIP: To create an entry that always appears at the top of the Address list, begin the Last name or Company field with a 
symbol, as in *If Found Call.* This entry can contain contact information in case you lose your handheld.

To view details of an address entry:
1. Tap the address entry in the Address list. The entry appears in Address view.
2. Tap Done when you are finished viewing the entry.
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Duplicating an Entry
You can duplicate existing entries, which can be helpful when you want to enter multiple people from a single organization. When 
you duplicate an entry, the word Copy appears next to the name in the First Name field. 

To duplicate an Address Book entry:
1. From the Address Book, tap a name you want to duplicate.
2. Do one of the following:

• Tap the Address Edit tab at the top of the screen; then tap Duplicate Record in the Record menu. 
• In the text input area of the screen, drag a diagonal line from the lower-left to upper-right to display the  

Command toolbar; then write a T in the text input area to initiate the Duplicate Record command.
3. Edit the record as necessary. 
4. Tap Done when finished. 

Selecting Different Types of Phone Numbers and Addresses
You can select the types of phone numbers or e-mail addresses that an Address Book entry displays. Any changes you make apply 
only to the current entry. 

To select a new label for an address, phone number or e-mail:
1. Tap the entry that you want to change in the Address list. 
2. Tap Edit.
3. Tap the pick list next to the label you want to change.

Tap a triangle

Select a new 
label  

from the pick list.

4. Select a new label.
5. Tap Done when finished.
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Editing Address Book Entries
You can change the type of information that appears in the Address List screen, categorize an entry, and hide an entry for security 
reasons. You can also delete entries. 

To edit an address book entry:
1. Tap the entry that you want to change in the Address list.
2. Tap Edit.
3. Tap Details.

4. In the Address Entry Details dialog box, select any of the following settings:
• Tap Show in List, and in the pick list tap which type of phone or other information you want to appear in the Address List screen. 

Options are Work, Home, Fax, Other, and E-mail. 
• Tap Category, and then tap a category in the pick list that you want to assign to the entry. 
• Tap Private to hide the entry when Security is turned on.

5. To attach a note to an entry, tap Note, enter information in the text input area, and tap OK.
6. To delete an entry, tap Delete.
7. Tap OK.

Changing the Address Book Display
You can change how Address Book lists are sorted, and you can add custom fields for entering additional information using 
Preferences. You can also have the Address Book display the last category you selected each time you return to the application.

To change the Address Book display:
1. In the Address list or in Address view, tap the Menu  icon.
2. Tap Options, and then tap Preferences.

3. Choose an option to sort Address Book lists from the List By pick list:
• Tap Last Name, First Name to sort alphabetically by an individual’s last name and then first name.
• Tap Company, Last Name to sort alphabetically by the company name, and then an individual’s last name.

4. Tap OK.
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To rename custom fields at the end of Address Edit screens:
1. In the Address list or in Address view, tap the Menu  icon.
2. Tap Options.
3. Tap Rename Custom Fields.

4. In the text input area, rename the fields to identify the information you will enter. The names you give the custom fields appear in all 
entries at the end of the Address Edit screen. 

5. Tap OK in the Rename Custom Fields dialog box.
6. Tap Done.

To control the Address Book display on returning to the application:
1. In the Address list or in Address view, tap the Menu  icon.
2. Tap Options, and then tap Preferences.

3. In the Address Book Preferences dialog box, select an option:
•  To have the Address Book re-display the last category you selected on returning to the application, tap the Remember Last 

Category check box to select it.
•  To have the Address Book display the All category on returning to the application, tap the Remember Last Category check box to 

clear it (check mark).
4. Tap OK.
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Using the To Do List
The To Do List is a convenient place to create reminders and prioritize the things that you must do.

Use the To Do List to do the following: 
• Make a quick and convenient list of things to do.
• Assign a priority level to each task.
• Assign a due date for any or all of your To Do List items. 
• Assign To Do List items to categories so that you can organize and view them in logical groups. For more information, see 

“Categorizing Records” in Chapter 5.
• Sort your To Do List items by due date, priority level, or category.
• Attach notes to individual To Do List items for a description or clarification of the task. For more information, see “Attaching 

Notes” in Chapter 5.

To open the To Do List:
 Press the To Do List application button on the front panel of your handheld. The To Do List opens and displays the category of items 

you last viewed.

 
NOTE: Press the To Do List button repeatedly to cycle through the categories in which you have items.

To Do List button
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Creating To Do List Items
A To Do List item is a reminder of a task that you must complete. A record in the To Do List is called an item.

To create a To Do List item:
1. Press the To Do List button on the front of your handheld to display the To Do List.
2. Tap New.

Tap New.

Enter new  
To Do List 

item.

3. Enter the text of the To Do List item. The text can be longer than one line.

 
TIP: You can add a name, address, and phone number to a To Do List item using the Phone Lookup option. For more 
information, see “Using Phone Lookup” in Chapter 5.

4. Tap anywhere on-screen to deselect the To Do List item.

 
TIP: If no To Do List item is currently selected, writing in the text input area automatically creates a new item.
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Setting To Do List Priorities
You can set priorities for tasks in your To Do List according to their importance or urgency. Items appear by priority and due date 
at the top of the To Do List by default, with 1 the highest priority. Changing the priority of an item may move it to a new position in 
the list. 

New To Do List items automatically have a priority of 1. If you tap an item before you create a new item, the new item appears 
beneath the selected item and has the same priority as the selected item.

To set priorities for To Do List items:
1. If priorities are not visible in the To Do List, tap Show at the bottom of the list, tap Show Priorities, and tap OK.
2. Tap the Priority number on the left side of the To Do List item.
3. Tap the Priority number that you want to set, with 1 the most important and 5 the least important. 

Tap here.

Tap to  
select priority 

number

To check off a completed To Do List item:
1. In the To Do List, tap Show. Tap Show Completed Items. If you clear this setting, your To Do List items disappear from the list when 

you complete (check) them. 

 
NOTE: Items that no longer appear on the list because Show Completed Items is turned off have not been deleted. They 
are still in the memory of your handheld. You must purge completed items to remove them from memory. See “Purging 
Records” in Chapter 5 for more information. 

2. Tap the check box on the left side of the item.

Completed  
To Do List item
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Changing Priorities and Due Dates
You can change the To Do List to display the due date assigned to an item, change its priority, and assign a category to the task with 
the To Do Item Details dialog box. You can then sort To Do List items by priority, due date, or category.

To change priorities and due dates for To Do List items:
1. In the To Do List, tap the item that you want to change.
2. Tap Details.
3. In the Details dialog box, tap No Date to open the Due Date pick list.

Tap here

4. Tap a due date to assign to the item. Options are Today, Tomorrow, One Week from the current date, No Date (to remove the due date 
from the item), or Choose Date (to display the date selector and select a date).

5. Tap Private to hide this item when Security is turned on. For more information, see “Making Records Private” in Chapter 5.
6. Tap OK.

 
TIP: If you turn on the Show Due Dates option in the To Do Preferences dialog box (tap Show to open), you can tap 
directly on the due date in the To Do List to open the pick list shown in Step 3.

To sort items in the To Do List:
1. In the To Do List, tap Show.
2. In the To Do Preferences screen, tap Sort By, and then select an option from the pick list:
3. Tap Priority, Due Date to sort items by priority first, and then by due dates. Tap Due Date, Priority to reverse that order.
4. Tap Category, Priority to sort items by category first, and then priority. Tap Priority, Category to reverse that order.
5. Tap OK.



60 iQue® 3000 Operating Instructions

BASIC APPLICATIONS > CHANGING PRIORITIES AND DUE DATES

Displaying Completed and Due Items
You can have the To Do List display completed items and their completion dates, as well as due items and their due dates. 

To set preferences for displaying items:
1. In the To Do List, tap Show.

2. In the To Do Preferences dialog box, choose from the following settings:
• Tap Show Completed Items to display your completed items in the To Do List. If this setting is turned off, completed To Do List 

items disappear from the list but are kept in the memory of your handheld. You must purge completed items to remove them from 
memory.

• Tap Show Only Due Items to show only the items that are currently due, past due, or have no due date specified. When this setting 
is active, items that are not yet due do not appear in the list until their due date.

• Tap Record Completion Date to replace the due date with the actual date when you complete (check) the item. If you do not assign 
a due date to an item, the completion date still records when you complete the item.

• Tap Show Due Dates to display the due dates for items in the To Do List and to display an exclamation mark next to items that 
remain incomplete after the due date passes.

3. Tap OK.
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Using the Memo Pad
The Memo Pad provides a place to take notes that are not associated with records in the Date Book, Address Book, or To Do List.

Use the Memo Pad to do the following: 
• Take notes or write any kind of message on your connected organizer. 
• Drag and drop memos into popular computer applications like Microsoft® Word when you synchronize using Palm™ Desktop 

software and HotSync® technology.
• Assign memos to categories so that you can organize and view them in logical groups.
• Write down phone numbers and other types of information. Later, you can copy and paste this information into other 

applications. 

To open the Memo Pad:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. 
2. Tap the Memo Pad icon.

Creating Memos
A record in the Memo Pad is called a memo. A memo can contain up to 4,000 characters. The number of memos you can store is 
limited only by the memory available on your handheld.

When you create a new memo, you can add information to it from the Address Book application, such as a phone number or 
address, using the Phone Lookup option. See “Using Phone Lookup” in Chapter 5.

To create a new memo:
1. Open the Memo Pad as described above.
2. Tap New.

 
TIP: You can also create a new memo by beginning to write in the text input area in the Memo List screen. The first letter 
is automatically capitalized and begins your new memo. 

3. Enter the text you want to appear in the memo. Use the carriage return stroke to move down to new lines in the memo.
4. Tap Done. 

You can categorize memos and sort them by categories. See “Categorizing Records” and “Sorting Records” in Chapter 5 for more 
information.
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Reviewing Memos
The Memo list displays the first line of a memo. This makes it easy to locate and review your memos. You can easily sort memos in 
the Memo list or move through memos using the Memo options.

To review a memo:
1. In the Memo List, tap the name of the desired memo.
2. Review or edit the text in the memo. 
3. Tap Done.

To move through a memo you are reviewing:
1. In the Memo List, tap the text of the memo you want to review. If the memo is longer than the display window, a scroll bar appears to the 

right of the memo.
2. Tap and drag the scroll bar to move the memo up or down.

To change the order in which memos appear in the Memo List:
1. In the Memo List, tap the Menu  icon in the lower-left corner of the screen of your handheld.
2. Tap Options.
3. Tap Preferences and choose one of the following options:

• Tap Manual to sort new memos in the sequence in which you create them.
• Tap Alphabetic to sort new and existing memos in numerical and then alphabetical sequence. 

4. Tap OK.
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Using the Calculator
The Calculator lets you perform general mathematical functions, such as addition, subtraction, multiplication, and division. 

Use the Calculator to do the following: 
• Perform basic calculations.
• Store and retrieve values.
• Display the last series of calculations, which is useful for confirming a series of “chain” calculations.

To open the Calculator:
 Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Calculator icon.

Using the Calculator Buttons
The Calculator includes several buttons to help you perform calculations.

The CE button clears the last number you entered. Use this button if you make a mistake while entering a number in the middle of a 
calculation. This button enables you to re-enter the number without starting the calculation over.

The C button clears the entire calculation and allows you to begin a fresh calculation.

The Plus/Minus button toggles the current number between a negative and positive value. If you want to enter a 
negative number, enter the number first and then press the +/- button.

The M+ button places the current number in memory. Each new number you enter with the M+ button is added to the total stored 
in memory. The number that you add can be either a calculated value or any number you enter by pressing the number buttons. 
Pressing this button has no effect on the current calculation (or series of calculations); it merely places the value into memory until 
it is recalled.

The MR button recalls the stored value from memory and inserts it in the current calculation.

The MC button clears any value that is stored in the Calculator memory.
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Displaying Recent Calculations
The Recent Calculations command lets you review the last series of calculations and helps you confirm a chain of calculations.

To display recent calculations:
1. In the Calculator application, tap the Menu  icon.
2. Tap Options, and then tap Recent Calculations.

3. When you have finished reviewing the calculations, tap OK.

Using QueNav
For detailed instructions on using the QueNav, refer to the Quick Reference Guide.

Que button
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CHAPTER 5: PERFORMING COMMON TASKS

In this section, the term “records” refers to an individual item in any of the basic applications—for example, a single Date Book 
event, Address Book entry, To Do List item or Memo Pad memo.

Creating Records
You can use the following procedure to create a new record in the Date Book, Address Book, To Do List, or Memo Pad.

To create a record:
1. Select the application in which you want to create a record.
2. Tap New. (For the Date Book only, select start and end times for your appointment and tap OK.)
3. Enter text for the record.

 
NOTE: The handheld automatically capitalizes the first letter of each field (except numeric and e-mail fields). 

4. Tap Details to select attributes for the record.
5. In the Address Book and Memo Pad only, tap Done.

Your handheld saves the new record automatically.

Editing Records
After you create a record, you can change, delete, or add new information at any time. When the screen is in edit mode, a blinking 
cursor appears within the information, and the information appears on a dotted gray line called an edit line.

You can enter text in any of the ways described in Chapter 2, “Entering Data in your iQue Handheld.”

Selecting Text
Select the text you want to edit using one of the following techniques:

• Double-tap on a word in a field to select the word.
• Triple-tap on any word on a line to select the entire line.
• Drag across a line of text to select some or all of the information or drag down to select text across multiple lines.

Using the Edit Menu
The Edit menu is available from any screen where you enter or edit text. As a general rule, the Edit menu commands affect selected 
text.

Do one of the following to display the Edit menu: 
• Tap the Menu icon ; then tap the Edit menu to display the commands in the menu. 
• Tap the inverted tab at the top of the screen; then tap the Edit menu to display the commands in the menu. 
• In the text input area, drag a diagonal line from the lower-left to upper-right to display the Command toolbar. To select a 

command, either tap the icon representing a command on the Command toolbar or draw the Graffiti® 2 shortcut in the text 
input area of your screen.

Command Toolbar
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Choose from the following commands, depending on the application you are using: 
• Undo: Reverses the last action taken. 
• Cut: Removes a selection from its current location to memory. You can then paste the text into another area of the current 

application or into a different application.
• Copy: Copies a selection and moves it to memory. You can paste the selection into another area of the current application or 

into a different application.
• Paste: Inserts a selection from memory into an area you select. Paste produces no result if you have not used the Cut or Copy 

commands. 
• Select All: Selects all the text in the current record or screen. 
• Keyboard: Opens the on-screen keyboard. Tap Done to close the keyboard. 
• Graffiti® 2 Help: Opens the Graffiti® 2 character stroke screen.

Deleting Records
You can delete records in any of the basic applications. 

To delete a record:
1. Select the desired record.
2. Do one of the following: 

• Tap the Menu icon , tap the Record menu, and then tap the Delete command. The Delete command differs depending on the 
application you are using. For example, “Delete Event” appears in the Record menu while you are in the Date Book, and “Delete 
Item” appears when you are using the To Do List. 

• Tap the inverted tab at the top of the screen, tap the Record menu, and then select the desired Delete command. 
• In the Details dialog box of the application, tap Delete, and then tap OK.
• Delete the text of the record. 

 
NOTE: In the Date Book, deleting the text of a repeating event deletes all instances of the event. 

•  In the text input area, drag a diagonal line from the lower-left to upper-right to display the Command toolbar; then tap the Delete icon 
or draw a Graffiti 2 “D” in the text area. A confirmation dialog box appears. 

Delete icon on Command toolbar

3. To archive a copy of the deleted file on your PC, select the Save Archive option. If you choose the archive option, the record is 
transferred to the archive file on your PC the next time you perform a HotSync® operation.

4. Tap OK to delete the record.
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Purging Records
Over time, as you use Date Book and the To Do List, you may accumulate records that are no longer useful. For example, events 
that occurred months ago remain in the Date Book and completed To Do List items remain in the list.

Outdated records take up memory on your handheld, so it’s a good idea to remove them by using Purge. If you think Date Book or 
To Do List records might prove useful later, you can purge them from your handheld and save them in an archive file. 

Purging is not available in Address Book or Memo Pad, so records from these applications must be deleted manually. 

To purge a record:
1. Open the application from which you want to purge records. 
2. Choose from the following options:

• Tap the Menu icon , open the Record menu, and then tap Purge. A confirmation dialog box appears.
• Tap the inverted tab at the top of the screen, tap the Record menu, and select Purge. 

3. Choose from the following options:
•  For the Date Book, select the Delete Events Older Than pick list and select an option—1 week, 2 weeks, 3 weeks, or 1 month.
•  For the Date Book or To Do list, select Save Archive Copy on PC to save a copy of purged records in an archive file on your 

desktop. Selecting this option transfers purged records to an archive file the next time you perform a HotSync® operation. 
4. Tap OK.

Categorizing Records
You can categorize records in the Address Book, To Do List and Memo Pad applications for easy retrieval. (The Date Book does not 
have categories.) When you create a record, it is automatically assigned to the currently displayed category. For example, if the All 
category is displayed, the record is assigned to the Unfiled category. A record can remain unfiled or it can be assigned to a category 
at any time. 

Each application has a default set of categories: 
• The Address Book includes Business, Personal, and QuickList categories.
• The To Do List includes Business, Personal, and All categories.
• The Memo Pad includes Business, Personal, and All categories.

You can rename or delete the default categories, and you can create new categories. Each application can have up to fifteen 
categories.

To move a record into a category:
1. Select the record you want to categorize.
2. Tap Details. (From the Address View screen, tap Edit first.)
3. In the Details dialog box, tap the Category pick list, select the desired category, and then tap OK. 



68 iQue® 3000 Operating Instructions

COMMON TASKS > CREATING RECORDS

To display a category of records:
1. Open one of the following applications: the Address Book, the To Do List, or the Memo Pad. 
2. Tap the pick list in the upper-right corner of the screen; then tap the category you want to display. 

Address Book category pick list

 
TIP: Pressing the Address Book, To Do List, or Memo Pad buttons on your handheld toggles through the categories 
assigned to each application, respectively. 

To add or edit application categories:
1. In the Address Book, To Do List, or Memo Pad application, choose from the following options:

• Tap the pick list in the upper-right corner of the screen, and tap Edit Categories. 

 (Continued on next page.)
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• In the Address Book, select a record and tap Edit; then tap Details. In the Category pick list, tap Edit Categories.
•  In the Memo Pad and To Do List, select a record from the list and tap Details. In the Category pick list, tap Edit Categories.

2. Select any of the following options:
• To create a new category, tap New, and enter a new name in the text input area. Tap OK. 
• To rename a category, tap it in the list to select it. Tap Rename, enter a new name in the text input area, and Tap OK.

• To delete a category, tap it in the list to select it. Tap Delete.
3. Tap OK.

To rename a category:
1. Tap the pick list in the upper-right corner of the screen; then tap Edit Categories. 
2. Select the category you want to rename; then tap Rename.
3. Enter the new name for the category, and tap OK.
4. Tap OK to exit the Edit Categories dialog box. 

 
TIP: You can move records from multiple categories into a single category by renaming all individual categories with a 
single category name. 
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Finding Records
Your handheld lets you find information in several ways:

• In standard Palm OS® applications, starting with the current application, you can locate selected text.
• In the Date Book, the To Do List, and the Memo Pad, you can use Phone Lookup to display the Address List screen and add 

the information from this list to a record.
• In the Address Book, you can use the Look Up option to enter the first letters of a name to scroll immediately to that name.

Finding Address Book Records
You can look up Address Book records using the scroll button on the front panel of your device or by typing the first few letters of a 
name in the Look Up option at the bottom of the address screen. 

To look up an Address Book record, do one of the following:
• From the Address screen, enter the first few letters of the name you want to locate. 
• Use the scroll buttons on the front of the device to scroll a screen at a time. Holding down a scroll button accelerates 

scrolling.

Using the Find Option
The Find option lets you locate text in any standard Palm OS applications on your iQue handheld. For example, if the text “dog” 
appears in the Address Book and the Date Book, the Find option displays both occurrences in the Find dialog box. Note that the 
Find option is not case sensitive; searching for “davidson” also finds “Davidson.” 

To use the Find option:
1. Tap the Find icon . 
2. Enter the text you want to find; then tap OK. 

 
TIP: Select text in an application before tapping Find to automatically place the text in the Find dialog box. 
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As your handheld searches for the text, you can tap Cancel to stop the search at any time.

 
NOTE: Find locates all matches that begin with the supplied text. It does not find words where the supplied text appears in 
the middle or at the end of a word.

Using Phone Lookup
The Phone Lookup option lets you add a telephone number from the Address list to an entry in another application. For example, 
you can add your dentist’s telephone number to your dental appointment date in the Date Book. 

To use the Phone Lookup option:
1. Display the record in which you want to insert a phone number. The record can be in the Date Book, the To Do List, or the Memo Pad.
2. Do one of the following: 

• Tap the Menu icon . Tap Options, and then tap Phone Lookup. 
• Tap the inverted tab at the top of the screen; then tap Options and tap Phone Lookup. 
•  In the text input area, drag a diagonal line from the lower-left to upper-right to display the Command toolbar. In the text area, write an 

“L”, the shortcut for the Phone Lookup command. 

3. Select a record or write the first few letters of the name you want to add. Tap Add to add the information to the record.

 
NOTE: You can also search based on selected text. Drag to highlight the text, then follow step 2 above. When the search is 
complete, the name and phone number of the candidate will replace the selected text.
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Sorting Records
You can sort lists of records in various ways, depending on the application. Sorting is available in applications that display lists: the 
Address Book, To Do List, and Memo Pad.

To sort records in the To Do List application:
1. Open the application to display the list screen.
2. Tap Show.
3. Tap the Sort By pick list, and select an option.

4. Tap OK.

To sort records in the Address Book and Memo Pad:
1. Open the application to display the list screen.
2. Do one of the following:

• Tap the Menu icon . From the Options menu, tap Preferences. 
• Tap the inverted tab at the top of the screen; then tap Preferences in the Options menu. 
• In the text input area, drag a diagonal line from the lower-left to upper-right to display the Command toolbar. In the text area, write an 

“R”, the shortcut for the Preferences command. 

3. In the Preferences dialog box, tap the option you want; then tap OK to sort the list. 
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To sort the Memo List manually:
1. Choose Manually from the Memo Preferences Sort By pick list. 
2. Tap and drag a memo to move it to a new location in the list. 

 
TIP: To display the list of your memos on your computer as you arranged them manually on your handheld, open the 
Memo Pad in Palm™ Desktop, click List By, and select Order on Handheld.

Making Records Private
In all the basic applications, you can make individual records private. Private records can be either masked or hidden. Private 
records remain visible and accessible until you select a security setting to Hide records. Private record names are covered with a 
gray bar when the security setting is set to Mask records.

If you have assigned a password to your device, you must enter it before private records are displayed. See “Assigning Security 
Options” in Chapter 3 for more information.

To make a record private:
1. In your application, do one of the following:

• Create a new record, tap Edit (if necessary), and then tap Details.
• Select an existing record, and then tap Details.

2. Tap the Private check box. Tap OK.
3. At the alert in the Private Records dialog box, tap OK.
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To hide private records:
1. Do one of the following:

• Tap the Home icon ; then tap Security .
• From within an application, tap the inverted tab at the top of the screen; then tap Security in the Options menu. 
•  From within any application, bring up the Command Bar and tap the padlock icon. To bring up the Command Bar, drag your pen 

diagonally across the text input area from lower-left to upper-right.
2. In the Change Security dialog box, tap Hide Records in the Current Privacy pick list; then tap OK.

To display private records:
1. Do one of the following:

• Tap the Home icon ; then tap Security .
• From within an application, tap the inverted tab at the top of the screen; then tap Security in the Options menu. 
•  From within any application, bring up the Command Bar and tap the padlock icon. To bring up the Command Bar, drag your stylus 

diagonally across the text input area from lower-left to upper-right.

2. From the Current Privacy pick list, tap Show Records; then tap OK.
3. If you have assigned a password, you must enter the password before the hidden records are displayed. Enter your password, and then 

tap Show.
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Attaching Notes
You can attach notes to records in all the basic applications except the Memo Pad. A note can be up to several thousand characters 
long. 

To attach a note: 
1. Display the entry to which you want to add a note. 
2. In Address Book only, tap Edit.
3. Tap Details. 
4. Tap Note; then enter the desired note. 
5. Tap Done. A note icon appears to the right of any item containing a note. 

The note icon indicates that 
a note is attached to this event

To review or edit a note:
 Tap the Note icon.

To delete a note:
1. Tap the Note icon.
2. Tap Delete; then tap Yes to delete the note. 
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Choosing Fonts
You can change the font style in all basic applications. You can choose a different font style for each application.

To change the font style:
1. Open an application.
2. Do one of the following: 

• Tap the Menu icon . From the Options menu, tap Font.
• Tap the inverted tab at the top of the screen; then tap Font in the Options menu. 
•  In the text Graffiti area, drag a diagonal line from the lower-left to upper-right to display the Command toolbar. In the text area, write 

an F, the shortcut for the Font command. 
3. Tap the font style you want; then tap OK.

Getting Information on an Application
You can get information on any application by displaying its About box. The About box displays the name and version number of 
the application. 

To display the About box:
1. Tap the Menu icon  from any location. 
2. In the Options menu, tap About. 

The text following the About command differs based on your location. For example, if you are in the Date Book, the command is 
About Date Book; if you are in the Address Book, the command is About Address Book. 
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CHAPTER 6: USING THE ATTENTION MANAGER

Many applications (such as Date Book and Clock) notify you (get your attention) with some sort of alarm. Attention Manager 
allows you to conveniently manage all of these notifications in one place. Alarms for appointments and messages can stack up while 
you are away from your device. Attention Manager lets you view them from a single list, where you can selectively dismiss or 
follow up on each event.

Applications signal for your attention at two different levels: insistent and subtle. Each is discussed in detail in this chapter.

Insistent Alarms
Insistent alarms open a Reminder dialog box and may play a sound or flash an LED, depending on your hardware configuration. 
Alarms continue until you snooze or dismiss them. If enabled, you can silence the alarm by tapping anywhere on the screen or 
pushing any button. Attention Manager will always open immediately when new insistent alarms are posted.

Using the Reminder Dialog Box
The Reminder dialog box has three buttons for responding to an alarm:

• OK: Makes the reminder go away, with no further notification.
• Snooze: Puts the Reminder dialog box to sleep for five minutes. After this time interval, the Reminder dialog box appears 

again. You can go back to the Reminder dialog screen right away by tapping on the blinking indicator in the upper-left corner 
of the box. For more information, see “Understanding the Blinking Alarm Indicator” later in this chapter. 

• Go To: Switches to the application that created the alarm and shows the record that caused the alarm, although you may have 
to navigate within the application. The alarm does not go off again.
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Setting Alarm Volume
You can control most alarm volumes globally in the General panel of the Preferences menu.

To set the alarm volume:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the  pick list in the upper-right corner of the screen and select General.
3. Set the volume using the Alarm Sound  pick list. If your device has a vibrate or alarm LED feature, turn these features on or off using 

the pick lists on this screen.

Setting Alarm Sound Effects
Some applications allow you to set the song or sound effect to use and how many times to play it. The example that follows 
illustrates how to set alarm preferences for the Date Book. Setting alarm preferences for other programs is similar.

To set alarm preferences for the Date Book:
1. Open the Date Book application and then tap the Menu icon .
2. Tap the Options menu and select Preferences.
3. Tap the Alarm Preset check box if you want alarms to sound; then select the following from the pick lists:

• How soon you want the alarm to sound before the event.
• The alarm song or sound effect (for example, Bird or Concerto).
• How many times the alarm repeats before giving up.
• The pause between each time the alarm sounds.



79iQue® 3000 Operating Instructions

ATTENTION MANAGER > INSISTENT ALARMS

Using the Reminders List Screen
The Reminders dialog box changes to a list of items that require your attention under two insistent alarm conditions:

• When a second application attempts to get your attention and the first has not been dismissed or snoozed.
• When a first application makes a second attempt and the first has not been dismissed or snoozed.

Each listed reminder contains the date and time of the event. Depending on the application displaying the reminder, you may see an 
icon representing the application and up to two lines of text. 

Tap the text or icon to open that item and delete the event from the Reminders list screen.

Tap the check box to clear that item (similar to a To Do List item). The Attention Manager draws a line through the text lines, 
pauses for a moment, and then removes the item from the list, although the original data remains in the application.

The Reminders list screen displays three buttons that are used to respond to all of the items in the list:
• Done: If the Reminders list appeared because of more than one insistent alarm, tapping Done closes the Reminders list 

screen, although the events remain in the application that created them. The Reminders list screen does not appear again 
unless you tap the blinking alarm indicator in the menu bar.

• Snooze: Puts the Reminders list screen to sleep for five minutes. After this time interval, the Reminders list screen appears 
again. You can go directly to the Reminders list screen by tapping on the blinking alarm indicator. For more detail, see 
“Understanding the Blinking Alarm Indicator” later in this chapter.

• Clear All: Removes all of the items from the list, but does not close the Reminders List screen. Tap this button to erase a list 
of events that have passed. 
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Subtle Alarms
Some applications provide a visual and optionally audible indication but do not otherwise disrupt your work flow. Subtle alarms do 
not display a Reminders list screen. Instead, a blinking indicator flashes in the upper-left corner of the title bar (of applications that 
allow it) when an alarm is present. 

Understanding the Blinking Alarm Indicator
A blinking alarm indicator appears in the upper-left corner of the screen in the menu bar (of applications that allow it) under the 
following conditions:

• While viewing a Reminders list screen, you tap the Done or the Snooze button.
• A subtle alarm is present.

The indicator appears in three different states:
• Off: The indicator is not shown at all when the list is empty.
• Blinking, two states: When the list is not empty, but there are no new items, the “star” indicator blinks on and off until the 

list is empty.

Blinking star

• Blinking, three states: When a new subtle alarm is received, the star will alternate flashing solid, exploded, then off, until 
you view the new event.

Tapping on the indicator opens the Attention Manager in list mode, even if there is only one item.
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CHAPTER 7: USING AN EXPANSION CARD

The iQue 3000 allows you to insert a microSD expansion card. You can insert and remove a card at any time without a reset. An 
expansion card allows you to back up data, increase memory size, or add games, reference materials, or other additional software or 
files to your handheld.

To insert a card in the iQue:
 Insert the card down into the card slot (as shown in the illustration above) until it clicks into place. The iQue automatically displays the 

contents of the card.

To remove a card from the iQue:
1. Make sure the iQue is not reading or writing data on the card.
2. Gently push the card down into the slot, then release it so the card pops partially out of the slot. 
3. Pull the card out of the iQue.

Displaying Contents of a Card
When you insert an expansion card, your handheld creates a new Applications Launcher category and displays in the category 
all applications listed in the card’s launcher directory. The new category for the expansion card is named after the expansion card 
volume; for example, the name “Card” is used throughout this section.

To display the contents of your card:
1. Tap the Home icon  on the front of your iQue until the “Card” category is displayed, 
 OR 
 Tap the Applications category pick list in the upper-right corner of the screen, then tap Card. The expansion card contents are displayed 

on the Applications menu.
2. To display any additional applications, tap the scroll bar.
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To launch an application on your iQue from a card:
1. Tap the Home icon .
2. Tap the  pick list in the upper-right corner of the screen and select Card.
3. Tap the application that you want to launch.

The selected application is loaded into memory and launched. If the application is already resident in main memory, it is not copied 
again, just launched.

To display information about an application on a card:
1. Tap the Home icon . Then tap the Menu icon .
2. Tap the App menu and select Info.

3. Tap the Device  pick list and select Card. The size of each application on the expansion card is displayed.

4. To display the application version, tap Version.

 
TIP: When you tap More, you access the Card Info application, described in the “Using Card Info” section later in  
this chapter.
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To copy an application on an expansion card to your handheld:
1. Tap the Home icon . Then tap the Menu icon .
2. Tap the App menu and select Copy.

3. Select the source and the destination using the From  and the Copy To  pick lists.

4. Select the application and then tap Copy. The application is copied to the selected destination.
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To beam an application on your card to another Palm Powered™ device:
1. Tap the Home icon . Then tap the Menu icon .
2. Tap the App menu and select Beam.
3. Tap the Beam From  pick list and select Card.
4. Select the application you want to beam and tap Beam. The application is beamed to the other handheld.  

Then tap Done.

 
TIP: Some applications and databases are copy-protected and cannot be beamed. These applications are listed with a lock 
icon next to them.

To delete an application on an expansion card:
1. Tap the Home icon . Then tap the Menu icon .
2. Tap the App menu and select Delete.
3. Tap the Delete From  pick list and select Card.
4. Highlight the application you want to delete and tap Delete. The Delete Application dialog box appears. Tap Yes to delete the file, or tap 

No to save the file. Then tap Done.

 
NOTE: Applications that are loaded in ROM (for example, Memo Pad) cannot be deleted, and are not listed.
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Using Card Info
The Card Info application displays summary information for each known directory type found on the expansion card. 

To use Card Info:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Card Info icon.

2. To rename the card, tap the Card Info tab in the upper-left corner of the screen and select Rename Card.

3. Enter the new name in the Rename Card dialog box and tap Rename.

(Continued on next page.)
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WARNING: Reformatting and expansion card will destroy its data.

4. To reformat the card, tap Card Info, select Format Card, and tap OK in the Format Card dialog box. 

5. To display help for Card Info, tap Card Info in the upper-left corner of the screen and select Help. Then scroll through the tips that are 
displayed.

6. To view information about Card Info, tap Card Info in the upper-left corner of the screen, and then tap About Card Info.
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CHAPTER 8: BEAMING INFORMATION

Your iQue handheld is equipped with an IR (infrared) port that you can use to beam information to another Garmin integrated 
handheld (or other Palm Powered™ handheld device) that is close by and also has an IR port. The IR port is located at the top of the 
handheld behind the small dark shield.

You can beam the following information between Palm OS®-based handhelds:
• The record currently displayed in Date Book, Address Book, To Do List, or Memo Pad.
• All records of the category currently displayed in the Address Book, To Do List, or Memo Pad applications.
• A special Address Book record that you designate as your business card, containing information you want to exchange with 

business contacts.
• An application installed in RAM memory.

 
NOTE: HotSync® operations can also be done using the IR port. See “IR HotSync Operations” in Chapter 9 for more 
information.

For best results, iQue handhelds should be between 10 centimeters (approximately 4 inches) and 1 meter (approximately 39 inches) 
apart, and the path between the two devices must be clear of obstacles. Beaming distances to other Palm Powered connected 
devices may be different.

Beaming a Record
To beam a record, business card, or category of records:
1. Locate the record, business card, or category you want to beam.
2. Tap the Menu icon .
3. Tap Record.
4. Choose from the following options:

• Tap Beam to beam an individual item.
• In the Address Book application only, tap Beam Business Card.
• Press the Address Book application button for about two seconds to beam your business card.
• Tap Beam Category (for records that are displayed in a category).
• Open the Command bar and use the Graffiti® 2 Command stroke B to beam the current entry.

Beaming a Business Card
To select a business card for beaming:
1. Press the Address Book button on the front of your device.
2. In the Address List, create a new entry or select an entry that contains the information you want on your business card. See “Adding and 

using Address Book Entries” in Chapter 4 for more information.
3. With the record you want to beam selected, tap the Menu icon .
4. Tap the Record menu and select Select Business Card. Tap Yes at the prompt.
5. Tap the Menu icon  again. Tap the Record menu and select Beam Business Card.
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NOTE: You can set the full-screen pen stroke to beam the current entry. See “To change what the full-screen pen stroke 
activates” in Chapter 3 for more information. 

6. When the Beam Status dialog box appears, point the IR port directly at the IR port of the receiving handheld.

Beaming an Application
To beam an application:
1. Tap the Home icon . Then tap the Menu icon .
2. Tap the App menu and select Beam.
3. Tap the application you want to transfer and tap Beam.

 
NOTE: Some applications are copy-protected and cannot be beamed, as indicated by a lock icon. 

4. When the Beam Status dialog box appears, point the IR port directly at the IR port of the receiving handheld.

Receiving Beamed Information
To receive beamed information:
1. Turn on your handheld. 
2. Point the IR port directly at the IR port of the transmitting handheld to open the Beam Status dialog box.
3. Tap Yes to receive beamed information.
4. Wait for the Beam Status dialog box to indicate that the transfer is complete, and then tap OK to display the new entry. 

Incoming records are placed in the Unfiled category.

Turning Off Beaming
To turn beam receiving on or off:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon .
2. Tap the pick list in the upper-right corner and select General.
3. In the General Preferences screen, tap the Beam Receive  pick list, and then tap On or Off.
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CHAPTER 9: EXCHANGING AND UPDATING DATA USING HOTSYNC® OPERATIONS

HotSync® technology lets you synchronize (exchange and update) data between one or more iQue handhelds and Palm™ Desktop 
software or another PIM such as Microsoft® Outlook. The HotSync process automatically synchronizes data between your handheld 
and Palm Desktop software. Changes you make on your handheld or Palm Desktop software appear in both places after a HotSync 
operation. HotSync technology synchronizes only the needed portions of files, thus reducing synchronization time. 

You can synchronize your data by connecting your handheld directly to your computer or indirectly with a modem or network. You 
can also perform HotSync operations using InfraRed if your personal computer supports it. This chapter describes how to select 
HotSync options and perform a HotSync operation using infrared communications, a modem, or a network. 

Performing a HotSync Operation for the First Time
You should have synchronized your iQue handheld for the first time when you used the Setup disk. If you did not synchronize your 
handheld at that time, you may experience problems. Refer to the Setup Guide included with the Setup disk for more instructions.

If you are a System Administrator preparing several handhelds for a group of users, you may want to create a user profile. See 
“Creating a User Profile” later in this chapter before performing the following steps.

Performing the First Local HotSync Operation
You must perform your first HotSync operation with a local, direct connection, rather than using a modem.

The following steps assume that you have already installed the Palm Desktop software. If you have not installed this software, see 
the Setup Guide included with the Setup disk for instructions.

To perform a local HotSync operation:
1. Connect your iQue to your computer.
2. Open the HotSync® software on your personal computer.
 The HotSync Manager must be running for the HotSync operation to proceed. If it is running, the HotSync icon appears in the Windows 

system tray. If the HotSync Manager is not running, click the Start button on the Windows desktop and choose Programs. Click 
the Palm™ Desktop software program group and choose HotSync Manager. You can also start the Palm Desktop software, which 
automatically opens the HotSync Manager.

3. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the HotSync icon in the HotSync application.
4. Select the user name you entered when you installed Palm Desktop software. The HotSync Progress dialog box appears and 

synchronization begins. 
 Every handheld should have a unique name. To prevent loss of a user’s records, never try to synchronize more than one handheld to 

the same user name.
5. Wait for a message on your handheld indicating that the process is complete.
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Creating a User Profile
You can create a user profile to load data into a handheld without associating that data with a user name. This feature allows System 
Administrators to configure several Garmin handhelds with specific information (such as a company phone list) before distributing 
them to their actual users. In Windows®, you use the File Link feature of the Palm™ Desktop software to import information from 
external files. For more information, see “Using File Link” later in this chapter. 

The user profile feature is designed only for a first-time HotSync® operation, before you assign a user name to a particular handheld. 

To create a user profile:
1. Open Palm Desktop software.
2. From the Tools menu, choose Users.
3. Click Profiles. 
4. Click New. Enter a unique name for the profile and click OK. 
5. Click OK to return to Palm Desktop software. 
6. Select the profile from the User list and create the data for the profile (for example, company phone list, and so on).

To use a profile for the first-time HotSync® operation:
1. Click Profiles.
2. Select the profile that you want to load on the handheld, and click OK.
3. Click Yes to transfer all the profile data to the handheld.

The next time you perform a HotSync operation, Palm Desktop software prompts you to assign a user name to the handheld.
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Selecting HotSync® Setup Options
You can choose when you want HotSync Manager to run. If necessary, you can adjust the local and modem HotSync  
settings as well.

To set HotSync options:
1. Click the HotSync Manager icon in the Windows system tray.
2. Choose Setup. 
3. Click the General tab, and select one of the following options:

• Always Available: Adds HotSync Manager to the Startup folder and constantly monitors the communication port for synchronization 
requests from your handheld. With this option, the HotSync Manager synchronizes data even when Palm™ Desktop software is not 
running.

• Available Only When Palm Desktop software Is Running: Starts HotSync Manager and monitors requests automatically when 
you open Palm Desktop software.

• Manual: Monitors requests only when you select HotSync Manager from the Start menu.

 
NOTE: If you are not sure which option to use, keep the default setting, Always Available.

4. Click the Modem tab to display the modem settings and adjust the options as needed. See “Conducting a HotSync® Operation Via 
Modem” later in this chapter for more information.

5. If you are attached to a network, click the Network tab to display the network settings and adjust the options as needed. See 
“Conducting a HotSync Operation Via a Network” later in this chapter for more information.

6. Click OK.
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Customizing HotSync® Application Settings
For each application, you can determine how records are handled during synchronization. The applications that handle these records 
are called “conduits.” By default, a HotSync operation synchronizes all files between the handheld and Palm Desktop software. 

In general, you should leave the settings to synchronize all files. The only reason you might want to change these settings is to 
overwrite data on either your handheld or Palm Desktop software, or to avoid synchronizing a particular type of file because you do 
not use it.

In addition to the conduits for Date Book, Address Book, To Do List, and Memo Pad, Palm Desktop software includes System and 
Install conduits. The System conduit backs up the system information stored on your handheld, including Graffiti® 2 ShortCuts. The 
Install conduit installs applications on your handheld. 

To customize HotSync application settings:
1. Click the HotSync Manager icon in the Windows system tray.

 
TIP: You can also click the HotSync command on the Palm Desktop software menu bar.

2. From the HotSync Manager menu, choose Custom.

3. Select the appropriate user name from the list.
4. Select an application in the Conduit list. Click Change.

 (Continued on next page.)
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5. Click to select the way you want to transfer data, or click Do Nothing to skip data transfer for an application.
6. Choose how long the setting will remain in effect:

• To have the setting affect only the next HotSync® operation, deselect Set As Default. Thereafter, the HotSync Actions revert to their 
default settings. 

• To use a new setting as the default, select the Set As Default option. Thereafter, whatever you selected as the default setting is used 
when you click the Default button in the Custom dialog.

7. Click OK.
8. Repeat steps 4 through 7 to change conduit settings for other applications.
9. Click Done to activate your settings.

IR HotSync Operations
Your organizer is equipped with an infrared (IR) port that supports the IrCOMM implementation of the standards for infrared 
communication established by the Infrared Data Association (IrDA). This means that you can beam data to any other device that 
supports the IrCOMM implementation of the IrDA standards. Most importantly, you can use the IR port to perform HotSync 
operations. You do not need a cradle to do this. This is very useful if you travel with an infrared-enabled laptop. You simply enable 
infrared communication on your laptop and handheld and follow the steps in “Performing an IR HotSync Operation” later in this 
section.

Preparing your Computer for Infrared Communication
Before you can perform a HotSync operation using the IR port, the computer you want to synchronize with must meet the following 
requirements:

• The computer must support the IrCOMM implementation of the IrDA standards.
• The computer must have an enabled infrared port built in or an enabled infrared device attached to the computer.

Desktop computers are likely to require an infrared device attached to a physical serial port. Laptops are likely to have a built-in IR 
port. Your computer must also have an installed infrared driver. 

Check your computer’s documentation to determine if the computer supports infrared communication.

To check if your Windows® computer supports infrared communication:
1. Click Start in the Windows taskbar.
2. Choose Settings, and then choose Control Panel.
3. In the Control Panel, look for the infrared icon.

If the icon is there, your computer is enabled for infrared communication. If it is not there, you need to install an infrared driver.

After you install the infrared driver or determine that the infrared driver is already installed, check the ports used by your computer 
for infrared communication.
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To determine the ports used for infrared communication:
1. On the Windows taskbar on your computer, click Start, choose Settings, and then choose Control Panel.
2. Double-click Infrared.
3. Click the Options tab.
4. Select Enable infrared communication.
 The COM port displayed in the drop-down box is the port where your infrared device is attached. It should be different from any port 

used by the HotSync® Manager.
5. Make a note of which port is listed as “Providing application support.” You need this information to configure the HotSync Manager for 

infrared communication. This port is the simulated port. It is the channel through which the actual infrared communication takes place 
between your computer and your handheld. 

6. Deselect all other check boxes in the Options tab.
7. Click Apply, then click OK.

Configuring HotSync Manager for Infrared Communication
Next you need to go to the HotSync Manager and specify that the infrared port should be used for the HotSync operation.

To configure HotSync Manager for infrared communication:
1. Click the HotSync Manager icon in the Windows system tray.
2. Make sure Local is checked on the menu.
3. Choose Setup.
4. Click the Local tab.
5. In the Serial Port drop-down box, select the COM port that was given as the simulated port in the Options tab of the Infrared Monitor.
6. Click OK.

 
NOTE: You cannot use your cable again until you reconfigure the HotSync® Manager to communicate with the port 
defined for cable synchronization.
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Performing an IR HotSync® Operation
After you complete the steps to prepare for an IR HotSync operation, it is easy to perform the actual operation.

To perform an IR HotSync operation:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Tap the HotSync icon.
2. Tap Local.
3. Tap the  pick list below the HotSync icon and select IR to a PC/Handheld.
4. Position the IR port of your organizer within a few inches of the infrared port of your computer.
5. Tap the HotSync icon to start the IR HotSync operation.

Returning to Using the Cable for HotSync® Operations
It is easy to return to using the cable for HotSync operations.

To return to cradle HotSync operations:
1. If needed, connect the cradle to a USB port on your computer.
2. Click the HotSync Manager icon in the system tray.
3. Choose Setup, and then click Local USB.
4. Click OK.

You can leave the HotSync application on your handheld set to perform IR HotSync operations and still use the cradle. This setting 
is useful if you perform HotSync operations with both your desktop computer and a laptop that you travel with. 
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Conducting a HotSync® Operation Via a Modem
You can use a modem, such as the Palm® modem accessory, to synchronize your handheld when you are away from your computer.

 NOTE: The first HotSync operation must be local, using the cable. After that, you can perform a modem  
HotSync operation.

To perform a HotSync operation via modem you must complete the following steps:
• Connect a modem to your computer.
• Configure the Palm Desktop software for use with your modem.
• Connect a modem to your handheld.
• Configure the Modem preferences on your handheld for use with your modem (Serial to Modem or IrCOMM to Modem). 

See Chapter 10, “Setting Connection and Network Preferences.”

Preparing Your Computer
You must perform a few steps to prepare your computer for a modem HotSync operation. Be sure to perform these steps before you 
leave your office so that your computer is ready to receive a call from your handheld.

To prepare your computer for a modem HotSync operation:
1. Confirm that the computer modem is connected and turned on, and that no communications applications, such as fax or telephony 

software, are running on a COM port.

 
NOTE: Make sure that the computer is disconnected from all online services, such as America Online (AOL) or 
CompuServe, to avoid conflicts with the COM port.

2. Start HotSync Manager if it is not already running, and choose Modem from the HotSync Manager menu.

 (Continued on next page.)
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3. Adjust the following options as needed: 
• Serial Port: To identify the port for the modem. If you are unsure of the port assignment, look at the Modem Properties in the Control 

Panel.
• Speed: To determine the speed at which data is transferred. Try the As Fast As Possible rate first, and adjust downward if you 

experience problems. This setting lets Palm™ Desktop software and your handheld find and use the fastest speed.
• Modem: To identify the modem type or manufacturer. Refer to your modem manual or face plate for its type or settings. If you are 

not sure of your modem type or your modem doesn’t match any that appear in the list, select Hayes Basic.
• Setup String: To identify the setup string for your particular modem. Not all modems require a setup string. Refer to your modem 

manual and enter the setup string if recommended by the manufacturer.
4. Click OK.

Preparing Your Handheld
In addition to preparing your computer, you must perform a few steps to prepare your handheld for a modem HotSync operation. 

To prepare your handheld for a modem HotSync operation:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the HotSync icon.
2. Tap Modem. Then tap the Enter Phone # field.

 
NOTE: If you plan to connect to your company’s dial-in server (network modem) instead of connecting to a computer 
modem, see “Conducting a HotSync Operation Via a Network” later in this chapter.

3. Enter the telephone number to access the modem connected to your computer. If needed, enter a dial prefix (such as “9”) to access 
an outside line, and then tap the Dial Prefix check box. If the phone line you are using for the handheld has Call Waiting, select the 
Disable call waiting check box to avoid an interruption during the modem HotSync® operation. If you want to use a calling card to place 
the call, select the check box and enter the calling card number. 

 
TIP: You can enter a comma in the field to introduce a “pause” in the dialing sequence. 

4. Tap OK.
5. Tap the Menu icon . 
6. Tap Options, and then tap Modem Setup.
7. Enter the settings. See “Setting Modem Configurations” in Chapter 10 for more information. 
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Selecting Conduits for a Modem HotSync® Operation
You can define which files and applications on your handheld synchronize during a modem HotSync operation to minimize the time 
required to synchronize data with a Palm™ Modem accessory. To define what synchronizes, use the Conduit Setup dialog box.

Applications that do not have a database (such as games) do not synchronize—even if you select the item in the Conduit Setup 
dialog box. 

To define which files/applications on your device synchronize during a HotSync® operation:
1. Tap the Home icon. Then tap the HotSync icon.
2. Tap the Menu icon . 
3. Tap Options, and then tap Conduit Setup.
4. In the Conduit Setup dialog box, tap the check boxes to deselect the files and applications that you do not want to synchronize during a 

modem HotSync operation. The default setting is to synchronize all files. 

5. Tap OK.

Performing a HotSync Operation via a Modem
After you prepare your computer and your handheld, and select your Conduit Setup options, you are ready to perform a modem 
HotSync operation.

To perform a modem HotSync operation:
1. Tap the Home icon. Then tap the HotSync icon.
2. Tap the Modem icon to dial the Palm™ Desktop modem and synchronize the applications.
3. Wait for the HotSync operation to complete.
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Conducting a HotSync® Operation Via a Network
When you use the Network HotSync software, you can take advantage of the LAN and WAN connectivity available in many office 
environments. The Network HotSync software lets you perform a HotSync operation by dialing in to a network or by using a cradle 
that is connected to any computer on your LAN or WAN (provided that the computer connected to the cradle also has the Network 
HotSync software installed, your computer is on, and the HotSync Manager is running).

The Network HotSync software has the following requirements:
• Your computer has TCP/IP support installed.
• Both your company’s network system and its remote access server support TCP/IP. (Your System Administrator has this  

information.)
• You have a remote access account. (If you don’t have an account, consult your System Administrator.)

Everything you need to connect to your company’s dial-in server (network modem) is included with Palm™ Desktop software and 
the handheld software. You need to activate the feature, however, on both Palm Desktop software and your handheld.

To prepare your computer for a network HotSync® operation:
1. Click the HotSync Manager icon in the system tray. 
 (The Windows system tray is usually in the lower-right corner on your computer display. The location may vary depending on the location 

of the taskbar and the version of Windows® you are using.)
2. From the HotSync Manager menu, choose Network.

HotSync Manager icon

3. From the HotSync Manager menu, choose Setup.
4. Click the Network tab and make sure that a check mark appears next to your user name. If no check mark appears, select the check 

box next to your user name.
5. Click OK.
6. Perform a HotSync operation.

The HotSync operation records network information about your computer on your handheld. With this information, your handheld 
can locate your computer when you perform a HotSync operation over the network.
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To prepare your device for a network HotSync® operation:
1. Tap the Applications Launcher icon. Then tap the HotSync icon. 
2. Tap the Menu icon. 
3. Tap the Options menu and select Modem Sync Prefs.
4. Tap Network.
5. Tap OK.

 
NOTE: See Chapter 10, “Setting Connection and Network Preferences” for information on configuring  
Network HotSync preferences.

Using File Link
The File Link feature lets you import Address Book and Memo Pad information into your handheld from a separate external file 
such as a company phone list. HotSync Manager stores the data in a separate category on your Palm™ Desktop software and your 
handheld. You can set the File Link feature to check for changes to the external file when you perform a HotSync operation. 

With File Link, you can import data stored in any of the following file formats:
• Comma delimited (.csv).
• Tab delimited (.tsv).
• Memo Pad archive (.mpa).
• Address Book archive (.aba).
• Text (.txt).

For information on how to set up a file link, see the Palm Desktop online Help.
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CHAPTER 10: SETTING CONNECTION AND NETWORK PREFERENCES

The TCP/IP software that is included in the iQue handheld operating system lets you connect with remote Internet Service Providers 
(ISPs) or dial-in (remote access) servers, using applications that let you view the transmitted data. 

To use TCP/IP, you must first create a configuration in Connection Preferences and then create Network preference settings. Then 
you connect to your ISP or dial-in server; see “Connecting to your ISP or Dial-in Service” later in this chapter.

For information on third-party applications that support TCP/IP, visit the Web site: http://www.palmsource.com/applications.

Connection Preferences
The Connection Preferences screen allows you to create configurations for communicating with a PC or modem. Configurations, or 
profiles, once activated, are available to various end-user applications running on the handheld. The Connection Preferences screen 
displays a list of available configurations that can be modified to reflect the required settings. This list varies depending on the 
software you have added to your handheld.

Connection Types
There are three basic types of connections you can choose from when configuring your preferences:

• Cradle/Cable: This connection type defines the direct cradle/cable connection between your organizer and your desktop 
computer. It is used when performing a local HotSync® operation. Your handheld is connected by its mini-USB port to the 
cradle or HotSync cable. The cradle/cable is attached to a USB port on your desktop computer.

• Serial to Modem: This connection type defines a communication between a modem attached to the serial port of your 
handheld and a modem.

• IR to a PC/Handheld: This connection type defines a connection between the IR port of your handheld and the infrared 
device of your computer or handheld device.

To modify Connection preferences:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon . 
2. Tap the  pick list in the upper-right corner of the screen and select Connection.

http://www.palmsource.com/applications
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Setting Modem Configurations
Modem configurations let your iQue handheld use a connected modem to communicate with remote devices, such as your ISP or 
dial-in server, to access a remote computer. 

You must set Network preferences, in addition to configuring Modem settings, to be able to use TCP/IP software included in the 
handheld operating system to connect to remote devices.

To set Serial to Modem preferences:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon . 
2. Tap the  pick list in the upper-right corner of the screen and select Connection.
3. Select Standard Modem and tap Edit. The name of the current configuration appears at the top of the screen.
4. Tap the Connect to  pick list and select the device you want to connect to.
5. Tap the Via  pick list and select the type of connection.
6. In the Dialing pick list, tap TouchTone or Rotary. Select Rotary only if your telephone service does not support TouchTone dialing.
7. Tap the Volume  pick list and select the speaker volume for the modem.
8. Tap the Details button at the bottom of the screen for the following additional settings:

• Tap the Speed  pick list and select the maximum speed for your modem to communicate with your handheld. (This setting does 
not control the speed at which your modem communicates with your telephone service.)

• Tap the Flow Control (Flow Ctl)  pick list, and select Automatic, On (Xon), or Off (Xoff) flow control for the modem connection.
• If necessary, edit the Init String text to change the modem setup string. 

9. Tap OK through each screen until you return to the Connection Preferences screen.
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Network Preferences
You must set Network preferences and Connection preferences to use the TCP/IP software included in the handheld operating 
system for remote connections. Network preferences let you set a password, telephone number, DNS number, IP address, as well as 
create a login script for remote connections. You can use a preset service template for your ISP or dial-in server and edit, save, and 
reuse settings. You can also create your own service template.

To set network preferences:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon . 
2. Tap the  pick list in the upper-right corner of the screen and select Network.
3. Tap the  Service pick list. Tap the predefined service template you want to use.

4. Tap the User Name field. Only two lines appear on the screen, but the field can contain multiple lines of text.
5. Enter your user name that identifies you on logging in to your ISP or dial-in server. Do not enter spaces in your user name unless your 

dial-in server accepts them. 
6. Choose whether to use a password when logging onto your ISP or dial-up service:

• To save your password for use during log-on, tap the Password field. Enter your password and tap OK. “Assigned” appears in the 
field. 

• To have your iQue prompt you for the password during log-on, leave “Prompt” in the Password field and do not enter anything. You 
should choose this option if you are concerned about security. 

 (Continued on next page.)
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7. Tap the  Connection pick list and select a connection. The list includes the configurations displayed in your Connection Preferences 
panel.

8. Tap the Phone Number field to display the Phone Setup dialog box.
9. Enter the phone number you use to reach your ISP or dial-in server. 

 
NOTE: MCI customers must enter the calling card number in the Phone # field, and the phone number in the Use Calling 
Card field.

10. If you do not need to enter a prefix, disable Call Waiting, or enter a calling card, tap OK.
• To enter a prefix before the telephone number to access an outside line, tap the Dial Prefix check box, and enter the prefix. (For 

example, many offices require that you dial “9” to dial a number outside the building.)
• To turn off Call Waiting, tap the Disable call waiting check box to select it, and enter the code to turn off Call Waiting. (If you do not 

know the code, contact your local telephone company for the appropriate code.) Call Waiting can end your network session if you 
receive a call while you are connected.

• To use a calling card to dial your ISP or dial-up service, tap the Use Calling Card check box. On the Use Calling Card line, enter 
three commas. (Each comma delays transmission of your calling card number for two seconds, to compensate for the delay before 
the number is entered.) Enter your calling card number. 

11. When you have finished setting up your phone number, tap OK.

Customizing Service Templates
You can create your own service templates from scratch or duplicate existing templates and edit the information. If you use one of 
the predefined service templates, you probably only need to enter your user name and telephone number. If you create a new service 
template, you may have to provide additional information.

To create a new service template:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon . 
2. Tap the  pick list in the upper-right corner of the screen and select Network.
3. Tap the Menu icon . 
4. Tap the Service menu and then tap New. A new service template (called Untitled) is added to the Service pick list.

To duplicate an existing service template:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon . 
2. Tap the  pick list in the upper-right corner of the screen and select Network.
3. In the Network Preferences screen, tap the  Service pick list. Tap the predefined service template you want to duplicate.
4. Tap the Menu icon . 
5. Tap the Service menu and then tap Duplicate. A copy of the service template is added to the Service pick list.
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To edit a service template: 
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon . 
2. Tap the  pick list in the upper-right corner of the screen and select Network.
3. In the Network Preferences screen, tap the  Service pick list. Tap the template you want to view details for. Then tap Details.

4. Tap the  Connection Type pick list, and select a connection type:
• PPP for Point-to-Point protocol. Select this type if you are unsure which you need. If PPP doesn’t work, ask your ISP or your system 

administrator for the correct connection type.
• SLIP for Serial Line Internet protocol.
• CSLIP for Compressed Serial Line Internet protocol.

5. Tap the  Idle Timeout pick list to specify how long your handheld waits to drop your connection when you switch out of a TCP/IP 
application, and select Immediate, 1 minute, 2 minutes, 3 minutes, or Never (until the power is off or your handheld times out).

 The Never option works best with the Palm™ Modem accessory.
6. Enter a DNS number following the instructions in the next section. 
7. Tap OK.

To delete a service template:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon . 
2. Tap the  pick list in the upper-right corner of the screen and select Network.
3. In the Network Preferences screen, tap the  Service pick list. Tap the template you want to delete. 
4. Tap the Menu icon . 
5. Tap the Service menu, and then tap Delete.
6. Tap OK.
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Entering DNS Numbers and IP Addresses
The Internet uses the Domain Naming System (DNS) to translate the names of host computers into IP addresses. A DNS number 
(or IP address) identifies a specific server that handles the translation services. Each DNS or IP address is a series of four numbers, 
from 0 to 255, separated by periods.

Anyone who logs onto the Internet must have a unique identifier called an IP address. This IP address can be either temporary 
(assigned automatically each time you log on) or permanent. 

Not all systems require that you enter a DNS number. Check with your system administrator. If a DNS number is required but not 
entered, logging on to your network may appear successful; however, the connection will fail if you try to use an application or look 
up information.

To specify a primary and secondary DNS number:
1. If your system requires DNS numbers, ask your Internet Service Provider or system administrator whether your system requires DNS 

numbers, and if so, what they are. 
2. In the Network Preferences screen with a service template selected, tap Details. 
3. Tap the Query DNS check box to deselect it.
4. Choose one of the following options:

• If your system does not require a DNS or you are not sure whether it does, leave the DNS field blank. 
• To enter the Primary DNS number, tap the space to the left of the first period in the Primary DNS field and enter the first section of 

the IP address using a number only, from 0 to 255; repeat the step for the remaining sections of the field. Use the same technique to 
enter the Secondary DNS number.

To specify the IP address: 
1. Check with your system administrator to determine whether your IP address is automatically (temporarily), or permanently assigned, and 

if permanent, get the address.
2. In the Network Preferences screen, with a service template selected, tap Details. 
3. Choose one of the following options:

• If your IP address is automatic and temporary, make sure that the IP Address check box is selected.
• If your IP address is permanently assigned, tap the IP Address check box to deselect it. In the permanent IP address field, tap the 

space to the left of the first period, and enter the first section of the IP address using a number only, from 0 to 255. Repeat the step 
for the remaining sections of the field.

4. Tap OK.
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Creating a Login Script
A login script is a series of commands that automates logging into your ISP. You can create login script files by selecting commands 
from in the Login Script dialog box. Some commands, such as Send, require additional information and have a parameter field to 
add the necessary data. You can also use non-ASCII and literal characters in your login script. See “Using non-ASCII Characters in 
Login Scripts” on the next page for more information.

To create a login script:
1. Follow the instructions to view details for a Service template (see “To edit a service template”).
2. In the Details dialog box, tap Script.
3. In the Login Script screen, tap the  End pick list.

4. Tap any of the following commands to select them from the pick list, and then enter additional information if a field  
appears:
• Wait For: Instructs your handheld to wait for specific characters from the TCP/IP server before executing the next  

command.
• Send: Transmits specific characters to the TCP/IP server to which you are connecting.
• Send CR: Transmits a carriage return or LF character to the TCP/IP server to which you are connecting.
• Send User ID: Transmits the User ID information entered in the User ID field of the Network Preferences screen.
• Send Password: Transmits the password entered in the Password field of the Network Preferences screen. If you did not enter a 

password, this command prompts you to enter one. The Password command is usually followed by a Send CR command.
• Delay: Instructs your handheld to wait a specific number of seconds before executing the next command in the login script.
• Get IP (for SLIP connections): Reads an IP address and uses it as the IP address for your handheld. 
• Prompt: Opens a dialog box and prompts you to enter text of some kind (for example, a password or a security code).
• End: Identifies the last line in the login script.

5. Repeat Steps 2 and 3 until you have completed the login script.
6. Tap OK, and then tap OK in the Details dialog box.
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Using Non-ASCII Characters in Login Scripts
If you know how to write custom scripts with non-ASCII characters, you can incorporate the caret (^char) character, carriage 
returns and line feeds, and literal characters in your custom login scripts.

• Use the caret (^ char) character to transmit ASCII command characters. If you send ^char, and the ASCII value of char is 
between @ and _, then the character is automatically translated to a single-byte value between 0 and 31. 

 For example, ^M is converted to a carriage return. If char is a value between a and z, then the character sequence is translated 
to a single-byte value between 1 and 26. If char is any other value, then the character sequence is not subject to any special 
processing. Thus, the string “Joe^M” transmits Joe, followed by a carriage return.

• You can include carriage return and line feed commands as part of the login script, when entered in the following format:
 <cr> Sends or receives a carriage return
 <lf> Sends or receives a line feed
 For example, the string “waitfor Joe<cr><lf>” waits to receive Joe, followed by a carriage return and line feed from the 

remote computer, before executing the next command in the script.
• You can use the backslash ( \ ) character to specify that the next character be transmitted as a literal character, and not be 

subject to any special processing ordinarily associated with that character. For example:
 \^ Includes a caret as part of the string
 \< Includes a < as part of the string
 \\ Includes a backslash as part of the string

Connecting to Your ISP or Dial-in Service
After you set Modem and Network preferences, you can easily connect to your ISP or dial-in server using PPP, SLIP, or CSLIP 
protocols. 

You can make the connection using Network Preferences commands or a third-party application. Connecting to an ISP requires 
a third-party application, such as a Web browser or news reader. For information on third-party applications that support TCP/IP, 
check the Web site: http://www.palmsource.com/applications.

To make or close a connection:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon . 
2. Tap the  pick list in the upper-right corner of the screen and select Network.
3. In the Network Preferences screen, tap Connect to dial the current service and display the Service Connection Progress messages. 
4. To see expanded Service Connection Progress messages, press the lower half of the Scroll button during login.
5. Tap Disconnect to terminate the connection between your handheld and your service.

http://www.palmsource.com/applications
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Troubleshooting TCP/IP Connections
If you have problems connecting to a network using TCP/IP, you can display information to troubleshoot the problem. You can 
display expanded Service Connection Progress messages. You can also display the Network Log to see all communication between 
your modem and dial-in server during login. This information can help your ISP or your System Administrator identify where and 
why the login communication fails.

Check with your system administrator to determine whether a DNS number is required. If a number is required but not entered, the 
connection may fail. See “Entering DNS Numbers and IP Addresses” in this chapter.

To expand the display of progress messages during login:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon . 
2. Tap the  pick list in the upper-right corner of the screen and select Network.
3. In the Network Preferences screen, tap Connect. 
4. To see expanded Service Connection Progress messages, press the lower half of the Scroll button during login. See “Connecting to 

your ISP or Dial-in Service” in this chapter for more information.

To view the Network Log:
1. Tap the Home icon . Select All from the  pick list in the upper-right corner. Then tap the Prefs icon . 
2. Tap the  pick list in the upper-right corner of the screen and select Network.
3. Tap the Menu icon .
4. Tap the Options menu, and then tap View Log.
5. Tap the Up and Down arrows of the scroll bar to see the entire Network Log.
6. Tap Done.
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Specifications
Physical
Size:  122 mm x 72 mm x 18 mm (4.80 in x 2.83 in x 0.71 in)
Weight:  153.6 grams
Display:  320 x 320 pixels, 16 bit color display with white LED backlight
Antenna:  Built-in patch antenna

Performance
GPS Receiver: 12-channel GPS receiver
Acquisition times: 
 Warm: Approx. 15 sec
 Cold: Approx. 45 sec
 AutoLocate®: Approx 5 minutes
Update rate: 1/sec. continuous
GPS Accuracy: < 15 meters, 95% typical
DGPS (WAAS) Accuracy: < 3 meters, 95% typical
Velocity Accuracy: 0.05 meter/sec steady state
Interfaces:  USB, Infrared

Power
Source:  Non-removable lithium-ion rechargeable battery
Operating Range: 0°C–50°C (32°F–122°F)
Battery Life:  Approximately 2 weeks standby time or approximately 10 days if used an average of 30 minutes per 

day with the backlight off. Battery life varies depending upon temperature and individual use patterns.

Internal System
Operating system: Palm OS® 5.2.1
Embedded Capabilities: GPS receiver, IrDA
Audio Hardware: Integrated speaker, headphone jack
Processor:  Based on 200 mHz TI OMAP technology
Internal Memory: 32 MB SDRAM
Expandable Memory: microSD
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Software License Agreement
THIS END-USER LICENSE AGREEMENT (“LICENSE”) IS A LEGAL AGREEMENT BETWEEN YOU AND GARMIN LTD. 
(“GARMIN”). ALL GARMIN SOFTWARE AND THIRD PARTY SOFTWARE THAT IS (i) INSTALLED IN THE PRODUCT AND/OR (ii) 
RECORDED IN MEDIA ATTACHED TO THE PACKAGE OR INCLUDED IN THE PACKAGE OF THE PRODUCT (EXCEPT AS MAY 
BE PROVIDED PURSUANT TO OTHER THIRD PARTY END-USER LICENSE AGREEMENTS) SHALL BE REFERRED TO HEREIN 
AS THE “SOFTWARE.” THE SOFTWARE IS OWNED BY, OR LICENSED TO, GARMIN LTD. (“GARMIN”) AND IS PROTECTED 
UNDER COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT TREATIES. THE SOFTWARE IS LICENSED, NOT SOLD. THIS 
SOFTWARE IS PROVIDED UNDER THE FOLLOWING LICENSE WHICH DEFINES WHAT YOU MAY DO WITH THE PRODUCT 
AND CONTAINS LIMITATIONS ON WARRANTIES AND/OR REMEDIES.
IMPORTANT: CAREFULLY READ THIS LICENSE BEFORE USING THIS PRODUCT. INSTALLING, COPYING, OR OTHERWISE 
USING THIS PRODUCT INDICATES YOUR ACKNOWLEDGMENT THAT YOU HAVE READ THIS LICENSE AND AGREE TO 
ITS TERMS. IF YOU DO NOT AGREE, RETURN THE COMPLETE PRODUCT TO: GARMIN INTERNATIONAL, INC. CUSTOMER 
SERVICE, 1200 EAST 151st STREET, OLATHE, KS 66062; OR GARMIN (EUROPE) LTD., UNIT 5, THE QUADRANGLE, ABBEY PARK 
INDUSTRIAL ESTATE, ROMSEY, SO51, 9DL, U.K.; OR GARMIN CORPORATION, NO. 68 JANGSHU 2ND ROAD, SHIJR, TAIPEI 
COUNTY, TAIWAN; WITHIN 10 DAYS OF THE DATE YOU ACQUIRED IT FOR A FULL REFUND.
1. LICENSE: Garmin (“we” or “us”) provides you with storage media containing the Software, which may also include digital cartographic 
data, “online” or electronic documentation, and printed materials (together called the “Product”), and grants you a limited non-exclusive license 
to use the Product in accordance with the terms of this License Agreement. The copyright and all other rights to the Product shall remain with 
us (and our licensors, as applicable). You must reproduce any copyright or other notice marked on the Product on all copies you make.
2. YOU MAY: 

a) install and use one copy of the Product on a single computer or network. This copy is to be used by only a single user at a time. If you 
wish to use the Product for more users, you will need an additional license for each user. 

b) make one copy of the Product for archive or backup purposes.
c) use a copy of the Product on a home or portable computer if that copy is never loaded at the same time that it is loaded on your  

primary computer.
d) transfer the Product to someone else only if you assign all of your rights under this License, cease all use of the Product, erase or 

destroy any copy (including the hard disk copy) made in support of your use of the Product, and ensure that the other person agrees IN 
WRITING to the terms of this License.

3. YOU MUST NOT:
a) make copies of, or provide access to, the Product except as expressly permitted in Section 2 of this License. 
b) translate, reverse engineer, decompile, or disassemble the Product except to the extent the foregoing restriction is expressly prohibited by 

applicable law.
c) rent, lease, loan, sub-license, distribute, assign, or transfer the Product or any unlock code for the Product except as set out in Section 2 

(d) above.
d) modify the Product or merge all or any part of the Product with another program.
e) use the Product for any unlawful purpose or in any illegal manner. 
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4. TERM: This License shall continue for as long as you use the Product. However, this License will terminate automatically without notice 
from Garmin if you fail to comply with any of its terms or conditions. You must agree, upon termination, to destroy all copies of the Product. 
The Limitations of Warranties and Liability set out in the next paragraphs shall continue in force even after any termination.
5. LIMITATION OF WARRANTIES AND LIABILITY: THE PRODUCT IS PROVIDED ON AN “AS IS” BASIS, WITHOUT ANY 
WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR ANY WARRANTY ARISING BY LAW, STATUTE, USAGE 
OF TRADE, OR COURSE OF DEALING. YOU ASSUME ALL RESPONSIBILITY AND RISK FOR THE USE OF THIS PRODUCT, 
AND GARMIN DISCLAIMS ALL LIABILITY FOR ANY LOSS, INJURY, OR DAMAGE RESULTING FROM USE OF THIS PRODUCT, 
WHETHER DIRECT OR INDIRECT, AND WHETHER OR NOT GARMIN HAS BEEN ADVISED OF OR HAS KNOWLEDGE OF 
THE POSSIBILITY OF SUCH LOSS, INJURY, OR DAMAGE. IN NO EVENT SHALL GARMIN HAVE ANY LIABILITY TO YOU 
OR ANY OTHER PERSON OR ENTITY FOR ANY COMPENSATORY, INDIRECT, INCIDENTAL, SPECIAL, CONSEQUENTIAL, 
OR EXEMPLARY DAMAGES WHATSOEVER, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOST OR 
DAMAGED DATA, OR OTHER COMMERCIAL OR ECONOMIC LOSS, EVEN IF WE HAVE BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. WE ARE ALSO NOT RESPONSIBLE FOR CLAIMS BY A THIRD PARTY. 
OUR MAXIMUM AGGREGATE LIABILITY TO YOU SHALL NOT EXCEED THE AMOUNT PAID BY YOU FOR THE PRODUCT. 
THE LIMITATIONS IN THIS SECTION SHALL APPLY WHETHER OR NOT THE ALLEGED BREACH OR DEFAULT IS A BREACH 
OF A FUNDAMENTAL CONDITION OR TERM OR A FUNDAMENTAL BREACH. Some states do not allow the exclusion of incidental or 
consequential damages or the limitation of duration of an implied warranty so the above limitations may not apply to you. 
IT IS YOUR RESPONSIBILITY TO USE THIS PRODUCT PRUDENTLY AND TO VISUALLY VERIFY STREETS, ROADS, ROAD 
SIGNS, AND DIRECTIONS. THIS PRODUCT IS INTENDED TO BE USED ONLY AS A TRAVEL AID AND SHOULD NOT BE USED 
FOR ANY PURPOSE REQUIRING PRECISE MEASUREMENT OF DIRECTION, DISTANCE, OR LOCATION. DO NOT ATTEMPT TO 
ENTER INFORMATION INTO THE PRODUCT, OR CONTROL THE PRODUCT, WHILE OPERATING A VEHICLE.
6. U.S. GOVERNMENT RESTRICTED RIGHTS. (I) THE PRODUCT and documentation are provided with RESTRICTED RIGHTS. 
Use, duplication, or disclosure by the United States Government is subject to restrictions as set forth in subparagraph (c)(1) and (2) of the 
Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer/Contractor is Garmin International, Inc., 
1200 East 151st Street, Olathe, KS 66062. (II) All Garmin technical data and computer software is commercial in nature and developed solely at 
private expense. Software is delivered as Commercial Computer Software as defined in DFARS 252.227-7014 (June 1995) or as a commercial 
item as defined in FAR 2.101(a) and as such is provided with only such rights as are provided in Garmin’s standard commercial license for such 
software. Technical data is provided with limited rights only as provided in DFARS 252.227-7015 (Nov. 1995) or FAR 52.227-15 (June 1987), 
whichever is applicable. 
7. EXPORT CONTROLS: You agree not to export or re-export the Product to any country in violation of the export control laws of the United 
States of America.
8. GARMIN LICENSORS: With respect to Third Party Software contained in the Product, the provisions of this License shall inure to the 
benefit of the licensors to Garmin of third party software contained in the Product. Such licensors shall be third party beneficiaries hereof, and 
shall have the right to enforce any and all rights and claims arising hereunder with respect to such third party software, including the right to 
bring an action directly against you, in the event of a breach by you of your obligations hereunder.
9. GENERAL: This License is the entire agreement between us, superseding any other agreement or discussions, oral or written, and may 
not be changed except by a signed agreement. This License shall be governed by and construed in accordance with the laws of the State of 
Kansas, United States of America. If any provision of this License is declared by a court of competent jurisdiction to be invalid, illegal, or 
unenforceable, such a provision shall be severed from the License and the other provisions shall remain in full force and effect.
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